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1 From 11 to 12

1

Main news from version 11 to version 12. (See Detailed changes of 11.1.x developer 
releases -pag. 8- for the full list of news).

General

 Use of Lognoter as help viewer enhancing some features (like ability to print, etc...).

 Status bar containing mesh information, render type, etc in the lower part of the 
window.

 Improved preferences window using a tree to organize the information.
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 Spheres and points rendering enhanced for big meshes (using textures, VBO,...)
 New and enhanced verctorial output: PostScript, PDF, SVG.
 Added new acceleradors: Control-1...4 for views, Control-t, Alt+Mouse to snap dynamic 
lines to horzontals, verticals or 45º diagonals.

Preprocessing

 New octree-based volume mesher: a robust and fast unstructured tetrahedra mesher, 
cappable to generate meshes from non-watertight definitions of the boundaries.
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 Native groups, to better organize and assign properties (boundary conditions and 
materials) to the different parts of the model.

 New advance bar mesh window, showing memory and time consumed graph along 
time.
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 Parallelization of mesh of volumes and surfaces

 STEP CAD format import (AP 214)
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 KML plugin, to import 'Google Earth' .kml/.kmz meshes in preprocess, and export 
results in postprocess.
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Postprocessing

 2D polygonal cut, new Line Thickness result visualization, smoothed gauss points 
results integrated in contour fill, lines, isosurfaces and other result visualizations.
 New graphs window (allow multiple graphs, etc)

 Result distribution window: to show a graph of frequency distribution of nodes or 
elements by result spans.
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 New Vtk format export (xml version .vtu, .vtp) and enhanced the Vtk import

 Huge meshes: new simplification mode for visualizing huge meshes, can be user 
switchable through  in the icon bar, or enabled as 'Fast rotation' mode. Geometric 
criteria is used and then results are interpolated at each result visualization, like c.fill 
and display vectors.
 Huge results files: enchanced and faster accesses using 'results cache'.
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Customization

 Implemented plugin volume mesher mechanism
 Several new GiD-Tcl commands and events

1.1 Detailed changes of 11.1.x developer releases

1.1.1 From v 11.1.9d to 12

What's new from version 11.1.9d to 12

General:

 Licence change to GiD 12.x (11.x licences are not valid for 12.x versions)
 Using the Alt key when creating lines, cuts or other objects, will snap the dynamic line 
to one of the axis or to 45 degrees.

Preprocess:

Fixed bugs in semi-structured volumes
Fixed bugs in contact volumes meshing
Fixed bugs in contact volumes creation

Postprocess:

Quadrilateras with 8 nodes:  now the central point ( 9th point in Quadratic 9 
quadrilaterals) and its result is interpolated in Vertex Buffer Object and Vertex Array 
drawing methods. This is done also for Hexaedrons with 20 nodes and Prisms with 15 
nodes. Including gauss point results and smoothed gauss points results. 
Point and Sphere options: separated size and detail options for points ( and point mesh 
style) and for spheres and circles.
Indexed result files: corrected problems when reading small files or incomplete results, 
at the end of the file or in the middle of a running simulation.
Display lists / Vertex Array / Vertex Buffer Objects: avoid rebuilding graphical structures 
too often when changing mesh properties like style, colours, etc., or when changing 
from Fast Draw to Normal draw mode.
AVI and FLV animations: corrected fps calculation when delay between frames is too big.
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1.1.2 From v 11.1.8d to 11.1.9d

What's new from version 11.1.8d to 11.1.9d

General:

 Use of Lognoter as help viewer
 Macros window: checkbox to show only the list of user-defined macros
Spheres / points:  added line styles when drawing spheres and points with quick 
textures:

preprocess: in render normal and flat these elements are drawn with a lines texture
postprocess: all lines, hidden lines and body with lines styles uses lines textures too.

Vectorial ps, eps, svg, pgf and pdf snapshots: smaller files, added vectorial pdf output, 
added vectorial option in the TakeSnapshot window, same snapshot/print to file options 
in pre and postprocess.
 Avoid crash meshing with tetgen with multiple threads

Preprocessing:

 STEP CAD format import (AP 214)
 'Insert GiD geometry' changed to 'Insert GiD model' because now mesh and groups 
information is imported too
 Fixed some bugs related to the creation of 'separated contact volumes'
Labels: corrected colours when drawing labels for spheres and when using Vertex Array, 
Vertex Buffer Object draw methods.
Labels: added NoImmediate / Immediate right mouse button menu to switch between 
the click and show label mode and the complex selection mode.
 Improved efficiency in advancing front 3d mesher.
 Added macro to toolbar to send each volume to a different layer
 Fixed bugs in contact volumes and surfaces
 Fixed bug of layers hierarchy

Postprocessing:

Indexed result files:  corrected problem when gauss points where defined between 
results and not at the begining of the file.
Gauss points:  increased verbosity now it will complain if gauss point definitions are 
repeated; also when the mesh name is specified for the gauss point, it will check it the 
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mesh exists.
Gauss points: now gauss points which can not be extrapolated to nodes are drawn as ( 
contour fill) coloured spheres for the Vertex Array, Vertex Buffer Object draw methods.
Memory leaks: keep track of shared temporal memory and delete them when not used 
anymore.
Binary result files: added checking for NaN and Inf values.
Animation:  corrected contour limits problem when changing result visualization in the 
middle of an animation and rewind it.
Isosurfaces:  corrected crash when converting isosurfaces to cut meshes when no 
surface was there or no elements where generated.
Indexed binary results files:

handling of gauss points definitions between results definitions
increased gauss points warning verbosity
option to rebuild the indices from the postprocess open file dialog

Scale Transformation:  Added scale transformation in copy window, as in preprocess it 
allows a uniform, or non-uniform, scaling of the model. This transformation, as the 
others, can be done only for viewing purposses or to create new meshes.
Deformation slide bar: ( from the deformation icon) corrected/enhanced its behaviour: if 
model is deformed using a result/factor, the slide bar will use the actual factor when 
deforming with the same/actual result. Resolution and size adjusted too. 
Isosurfaces: also for smoothed gaussian results
Contour Fill / Smooth Contour Fill  menus merged together; and the same for Contour 
Lines / Smooth Contour Lines menus.
Result surface: also for smoothed gaussian results.
Line thickness: also for smoothed gaussian results.
Line thickness:  render correctly lines, and extrapolate values at nodes, with gaussian 
results when they do not include the nodes of the lines.

Customization:

 Implemented plugin volume mesher mechanism
several events: GenerateSphereMesh (to be invoked to generate the mesh of 
spheres)

   variable SphereMesher to store the kind of sphere mesher

several Tcl procedures: (see gid_plugin_mesh.tcl)

GiDMeshVariables TclOO superclass to derivate subclasses for variables of plugin 
meshers

GiD_RegisterPluginMeshVariablesClass / GiD_UnRegisterPluginMeshVariablesClass

GiD_RegisterPluginPreferencesProc / GiD_UnRegisterPluginPreferencesProc

GiD_RegisterPluginGenerateSphereMesh / 
GiD_UnRegisterPluginGenerateSphereMesh

PluginMeshVariablesClass_VariableManager, to access values of variables

CreateWidgetsFromXml::AddAfterName , to modify the preferences window
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GiD_RegisterProcedureToInvokeAfterSourcePlugins, to do something after plugins 
are sourced

 GiD_Mesh get element returns also radius for spheres and circles, and normal for circles
 New Tcl/Tk packages added

 gdi (access to a subset of Windows drawing routines)
 printer (Windows printer interface and utilities)
 Lognoter, pdfwriter, tktablet, xml2pdf (to use lognoter as help viewer)

1.1.3 From v 11.1.7d to 11.1.8d

What's new from version 11.1.7d to 11.1.8d

General:

File dialog: new options to sort files and folders alphabetically ( exaple: a1 a11 a2), by 
dictionary ( understanding integers within name, example: a1 a2 a11), by modification 
date ( newer first) and by size ( bigger first). These options are accesible using the right 
buttom mouse menu.
New preference: 'checkbox updated version' variable in General preferences window.
New key bindings:

 Control-1 to 4 for common views
 Control-t to set the focus in the command line to write commands.

Preprocessing:

Selection 'Children of', to select child entities of a picked parent.
Entities of frozen layers drawn in gray
Fixed bug with orthogonal view to z axis, the model is drawn in a wrong place.
Fixed error saving a mesh with only nodes but not elements (nodes were not saved)

Postprocessing:

New Vtk format export (xml version .vtu, .vtp) and enhanced the Vtk import.
Open Multiple files: corrected problem when reading an unordeder list of files.
Several analysis, different results: corrected problem which arised when doing first a 
result visualizacion ( c.fill, display vectors) of a results of analysis/step AS1, then 
deforming the model with another results of another analysis/step AS2, and then gid 
tries to actualize over the deformed model the first result visualization.
Polygonal cut:  corrected crash when a polygonal cut was deleted and another 
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postprocess model was loaded.
Iso-surfaces:  corrected problem when a mesh is drawn as points, and it was switched 
off, it was still drawn if it had an isosurface.
Iso-surfaces: corrected problem when all meshes were switched off and a zoom frame 
was selected, the iso-surface was moved out of the view.
Line Thickness: support for several gauss points in line elements, before only 1 gp was 
handled.
Line Thickness: correct drawing of thick+nice lines for render flat and for render smooth.
Line Thickness:  correct update of line thickness visualization when some result 
surface/line thickness options were changed.
Smooth Contour Lines: added this new result visualization, to draw contour lines using 
smoothed gauss points results, like Smooth Contour Fill.
Iso-surfaces:  corrected problem ( too much memory was used) when converting 
iso-surfaces into cuts ( proper meshes).
Contour lines: new option to set the widht of the lines of this visualization, they will also 
be scaled when creating high resolution images.
Animating smooth contour fill:  corrected crash when fixing global limits when several 
meshes are used at different time steps.

Customization:

New command GiD_Book material|condition create|set|exists to create a book, check if 
exists or set the book of a condition or material
GiD_Info materials: new option to list materials of a book: GiD_Info materials($book)
GiD_ModifyData: new option -book to change a material or condition to other book
GiD_CreateData: material now return the number of the new material
GiD_Info Mesh -post NumElements:  implemented missing option -post -step 
$step_index
GiD_Info Mesh -post Nodes: added -step $step_index option

1.1.4 From v 11.1.6d to 11.1.7d

What's new from version 11.1.6d to 11.1.7d

General:

USB linux passwords: now passwords registered using USB memory sticks are 
recognized on Ubuntu 13.04 and Fedora 18 ( linux kernel >= 3.8).
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Tk Img package incorporated in GiD. Other packages actualized.
Multiple windows:  corrected size distribution problem when multiple windows were 
enabled.
Batch mode: corrected some problems and issues when running GiD in this mode.
Selection lines by software ( emulate front buffer): corrected problem when GiD window 
is very big on modest graphic cards or using GiD in 'safe mode', or gidx.
MS Windows 64:  corrected problem with progress bar and results cache when reading 
files with size > 2GB.

Preprocessing:

Perspective: corrected normal render of geometry when model is using huge 
coordinates.
STL binary on Linux: corrected problem when reading binary STL's on Linux x64.
Conditions over groups: if name is present and not repeated, it's used, otherwise a new 
name is generated.

Postprocessing:

Result Surface:  splitted into two result visualizations: Result Surface,  for everything 
except lines, and Line Thickness, with new icon in the Results icon bar.
Result Surface: corrected drawing problem when using Result surface with gauss points 
results.
Line thickness: now thickness is correctly drawn as world absolute thickness, and not 
screen size fixed.
Legends: correct width calculation for high resolution prints.
Spheres: corrected zoom frame problem when reading only one sphere.
Polygonal cut:  corrected problem when doing polygonal cuts on models with huge 
coordinates.
Integral graphs:  drawing symbol over the original model to tell that there is a integral 
graph.
Iso-surface export: corrected problem when exporting iso-surfaces as cuts.
Iso-surfaces: corrected isosurface style problems, when it's bad defined --> set at least 
body visualization of isosurfaces. 
Read/save state: now cuts converted to set are also saved and read between session.
Several Meshes: corrected problem with several meshes with different number of layers 
at each time step, when animation a deformation and a contour fill.
Graphs:  Point evolution and point graph ( res1 vs. res2): do not include points with 
undefined results in graphs.

Customization:

New GiD-Tcl events:
proc AfterSaveAs { old_name new_name } { body... }
proc AfterChangeViewMode { mode } { body... }
proc AfterDeleteGroup { name } { body ... }

New GiD-Tcl command: GiD_Togl current|list
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Retrieve Problem Type:  corrected problems when cancelling download and suggesting 
platforms and version when current version on current platform is not found.
Calculation: corrected problem with fast calculations in Linux, which caused gid to lock.

1.1.5 From v 11.1.5d to 11.1.6d

What's new from version 11.1.5d to 11.1.6d

General:

Views:  corrected problem when preprocess views were used in postprocess and 
viceversa.
Animation Scripts: window works again, scripts can be read, saved and exported again. 
Added cehckbutton to link animation with results animation window, still alpha.
VA/VBO: fast render methods checking enhanced when graphics driver is badly installed 
or corrupted due to partial actualizations.
Added a lower information bar containing zoom level, number of nodes and elements, 
render type, coordinates with length units and indicator of preprocess/postprocess.
Window automatic placement: windows between pre- and post- remain open instead of 
being closed and, sometimes, opened again. Batch window and preferences window 
remain open between pre and post.
Retrieving problemtypes:

Better handling of versions and suggestions if selected problemtype can not be found 
for the current platform, for examples MS Windows 32 bits problem type will be 
offered if MS Windows 64 version can not be found. 
Window will pop-up to provide feedback to the user when he selectes a problemtype 
to download directly from the menu. 
Asking for administrative privileges when retrieveing problemtype if the installation 
directory is restricted.
Linux: corrected problem now problemtypes folder is scanned and problemtype's 
icons are read so that they appear in menus and file browsers.

Linux:  corrected problem when launching internet browser in linux with links to web 
pages.
Linux: if GiD is installed on restricted directory, i.e. as root, then later the user will be 
asked for permission to save password and retrieve problemtypes.

Preprocessing:
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 New advancing mesh window, showing graph along the time.
 Fix bugs in octree based volume mesher.

Postprocessing:

Deformation: if some nodes do not have the deformation defined, then when the model 
is deformed, these nodes will be placed 'out of sight', instead of not being deformed at 
all.
Results animation:

 corrected problem with which user defined limits were not hold when doing 
animation of several results.
 verify only user specified step in the from: and to: entries when doing animation of a 
deformation of an analysis and c.fill of another one.
iso-surfaces with contour fill:  now the animation of these two combined result 
visualization can be done without the 'several results' option.

Contour colours window:  corrected resizing problem and drawing of more than 100 
colours. Now the first time the user selects the design map option, the rainbow colours 
are shown.

Customization:
Data window: avoid problem of non equispaced columns of tables, now it shows the true 
table header too.
Data window: fixed problems of unordered rows with copy/paste of table values.
 New GiD-Tcl events for postprocess: 

AfterCreateVolumeSet, AfterRenameVolumeSet, BeforeDeleteVolumeSet
AfterCreateSurfaceSet, AfterRenameSurfaceSet, BeforeDeleteSurfaceSet
AfterCreateCutSet, AfterRenameCutSet, BeforeDeleteCutSet

New Tcl/Tk packages added
Img (Tk images several formats)
Twapi (Tcl Windows API)
Tcllib 
Tklib

1.1.6 From v 11.1.4d to 11.1.5d

What's new from version 11.1.4d to 11.1.5d
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General:

 New button to create a new interval inserted in the specified location
High-resolution pictures: corrected problem which arised on Intel graphics and on Linux 
and on MS Windows.
Initial GiD window:  adjusted size of first-time initial configuration window for small 
screens.
File dialog:  now the last used directory is remembered for images, graphs, postfiles 
besides normal files and projects.
TTFonts: a list of the TTF fonst is saved between GiD sessions. The TTF fonts of the 
system are queried if the list does not exists or at user request, from the preferences 
window. With this option the font preferences panel will open faster.
Draw legend with names when drawing Groups

Preprocessing:

 Utilities->Swap normals, new option to set normal of skin surfaces/curves of selected 
volumes/surfaces pointing inside
Circles and spheres:  also drawn as points when using the quick draw mode for those 
elements, besides the internal textura and nice options.
Legends: new options for condition and material legends, as in post: draw with opaque 
background and with a surrounding border. They are also in the preferences windo, 
under Graphical --> Appearance. Both are also used in postprocess legends.
 Fixed bugs in boundary layer meshing.
 Fixed bugs in octree volume mesher.

Postprocessing:

Results cache:  improved performance when results are retrieved from disk by sorting 
the accesses.
Comments: new parameter for comments %tcl() to evaluate a tcl command and display 
it's result as comment, for instance: "Step id = %sv, correct step value = %tcl(expr $sv 
* 2.5 + 3.4)" --> will translate to "Step id = 1, correct step value = 5.9".
2D Polygonal cut ( former Cut Wire):  polygonal cuts can be done on triangular and 
quadrilateral surfaces, any point can be selected and not just over element edges like 
the 'cut wire' option. These cuts can be imported and exported and are saved between 
sessions, like normal cut planes. Quadratic elements are handled as linear ones, like 
normal cut planes. Nodal results and 1gp results are passed to the new cuts as well.
Circles and spheres: corrected error when drawing these elements as quick points using 
the Vertex Array ( VA) or the Vertex Buffer Object ( VBO) methods.
Utilities-->List: corrected bug when listing cached results
Result surface:  corrected problem when drawing extruded result surface with va/vbo 
drawing method.
Binary results:  added support for indexed binary postprocess files to speed-up the 
results cache mechanism and the reading process. 
Two new preferences has been added under the Results' cache label: 

Use indexed binaries: uses the index file just to access the data
Use indexed results information: if present in the index file, the results information 
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will be used instead of reading it directly from the whole postprocess binary file.
If the index file is not present, then it will be created ( if the 'Use indexed binaries' 
option is enabled). The index file will be regenerated if the original binary file is newer 
than the index file. The user can also recreate the index file by using 
Files-->CreateBinaryIndex in the right buttons menu.

A new command line option has been added 'gid -createindex 
results_binary_file.post.bin' to create the index file from the command line or in a script.

Change orientation:  new option to change orientation, and their normals, of surface 
meshes ( triangles, quadrilaterals and circles) under 
Options-->Geometry-->Swap orientation of visible surfaces.
Display vectors:  corrected drawing error when drawing as vectors a component of a 
resullt vector with fxed size vectors.
 Graphs window enhanced:

 graphs selection: double click -> edit selected graph, right mouse -> contextual 
menu to delete or edit graph
 graphset preferences of legend: 
  combobox to set position instead of swap it, and allow also hide the legend
  allow hide graphset text of the legend
  access to opaque-transparent variable (common to all legends)

Customization:

 GiD_IntervalData create ?<number>? ?copyconditions? : new option <number> to be 
inserted in the specified location
 GID_Info condition, new suboption -count to return the amount of enties with the 
condition instead of the list of values
New Tcl command: GiD_Info opengl to get info about Opengl/glew version and renderer.
 New Tcl subcommands related to graphs:

GiD_GraphSet edit <graph_set> legend_location|title_visible <value>
GiD_Info postprocess get graphs_option LegendLocation|TitleVisible
GiD_Graph selection set|get|swap <value> <graph_name>
GiD_Graph get_name <num> ?<graph_set>?

1.1.7 From v 11.1.3d to 11.1.4d

What's new from version 11.1.3d to 11.1.4d

General:
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 Fixed bugs in new preferences window.

Preprocessing:

 Fixed bugs in octree volume mesher.

Postprocessing:

 Points, spheres and circles sizes:  maximum limit restriction relieved and turned into a 
warning, values above the maximum limit may cause that these elements not be drawn 
if Quick draw mode is used.

1.1.8 From v 11.1.2d to 11.1.3d

rom v 11.1.1d to 11.1.2d

What's new from version 11.1.2d to 11.1.3d

General:

Spheres + VBO:  added memory limit when drawing thousands of spheres with high 
detail level. If limit is reached, then the detail level is lowered. At detail level 0, spheres 
are drawn as points. The memory limit is set to 1 GB, which implies that up to 120 
thousand spheres can be drawn with a nice detail level (n.d.l.) of 9, i.e. ~630 triangles 
per sphere, 150 thousand spheres up to n.d.l. 8 ( 510 triangles), ..., 560 thousand up to 
n.d.l. 4 ( 128 triangles). 
 Problem saving the GiD password avoided (Windows platform with 'User Acess Control' 
enabled). Administrator permission is asked to allow write the password to file.
 gid -tclsh ?<tcl_filename>? to source a file in a tclsh or open a interactive Tkcon 
console (e.g. to do special thinks with and auxiliary script or execute the solver 
calculation)
 MouseWheel now zoom the model directly, without require pressing the <Shift> key
 Improved preferences window using a tree to organize the information.

Preprocessing:

 Improvements in Octree based mesher.
Spheres rendering: new draw and faster mode for spheres which uses a texture to draw 
a sphere. Can be enabled and disabled in the Graphical panel of the Preferences 
window:
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 Fixed some bug related to groups, and some new features, like select dependencies, 
and list conditions applied to some group

Postprocessing:

Result distribution window: to show a graph of frequency distribution of nodes or 
elements by result spans.

Multiple graphs: now it is possible to have more than one graph, separating them by 
'graph sets' that can be handled from the 'Graphs window'
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Table to edit graph points enhanced: multiple selection, allow copy/paste in Excel, etc.
Graphs are drawn inside the 'graphs window' instead of the main window, to 
simultaneously see the model and graphs.
Graphs operations enhanced: now it is possible to operate with two graphs,e.g. to 
substract them, with different amount of x values.
Graphs: Labels are properly showed with logarithmic scale.
Graphs: If applicable units are drawn in the axis label.
Graphs: Result step is specified in the graph title.
Cut Wire: now all edges of elements of the model between user specified points are cut. 
Still the user should pick points lying on model edges.
Stream lines: better calculation of initial time step to create stream lines.
Stream lines:  new 2D constraint  option, with which the stream lines calculations 
discards the z-coordinates of the mesh and the z-component of the vector field. The 
stream lines is projected to the triangle or quadrilateral mesh though.

Customization:

 New GiD-Tcl event BeforeReadGIDProject that allow to return -cancel- to abort it.
 New GiD-Tcl event AfterSaveFile raised when exporting a file in some format.
 New macro to import a selection of multiple IGES files and send then to layers named 
with file names and collapse independently.
 New GiD_Info parametric uv_projection_z_fromcoord subcommand, to get the location 
of a point projected in direction z on a surface
 New GiD-Tcl command: GiD_GraphSet create|current|delete|edit|exists|list
 Addet options edit and exists to the GiD-Tcl command GiD_Graph, and an optional 
<graphset_name> parameter could be specified.
 GidUtils::TkwidgetGetVector3D predefined Tkwidget procedure to show in a single row 
three entries for x, y, z real coordinates of points or directions.

1.1.9 From v 11.1.1d to 11.1.2d

What's new from version 11.1.1d to 11.1.2d
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General:

 File 'download.xml' to get a problemtype on demand from the 'Internet retrieve' 
repository
 New KML plugin, to import 'Google Earth' .kml meshes in preprocess, and export results 
in postprocess, .kmz compressed files are supported.
 Plugin Ema3D, fixed bug with some special description of cartesian meshes.
Grey images: Corrected problem with grey images when they were used as textures or 
background.
new command line option -noredirect : to avoid redirection of stdoutput and stderror 
messages and print them in the console.
Linux: some redraws avoided when a tooltip or a menu is displayed over the graphical 
window

Preprocessing:

 Material window: added a button to allow rename a material
 Import xyz files: option to triangulate points or nodes after import, and allow XYZ first 
line header.
 Allow generate structured mesh on surfmeshes of 4 or 3 sides.
 Bugs fixed in octree volume mesher.
 Parallel processing used in octree mesher (unstructured volume mesher). (Number of 
threads to be used defined by the user in the Utilities->Preferences window, General 
tab).
 Fixed bug in the creation of ContactVolumes when its surfaces have holes.

Postprocessing:

New Calculix plugin, to import 'Calculix' .frd mesh and results in postprocess 
(Files->Import->Calculix...)
Labels of results:  corrected problem which appeared sometimes with labels of results, 
when the timestep was changed the label of the result change to label of node number.
Spheres:  when drawing sphered / particles / points in nice mode, the quads now are 
drawn as 4 triangles, instead of 2, so the render quality has been increased a bit.
Textures:  when applying textures, if the render mode is vertex array or vertex buffer 
object, it is changed to display lists, because textures mapped on meshes are still not 
supported in va/vbo mode.
Textures --> ScreenMap: if GeoReference information is present, it can be shown and 
used to project the image to the mesh, f.i. applying terrain images to a terrain mesh.
Textures: corrected problems: when changing mesh style, texture now remains on; and 
when applying a texture, draw no results ( c.fill & co) --> c.fill hides texture
Results: corrected bug when result's name is > 100.
Reading TIFFs: ( for textures or background) support for tiff using colour maps and 
inverse black-white maps.
XYZ import: option to triangulate/tetrahedrize the point cloud after importing.
line graphs: corrected bug for line-graphs when triangles are aligned and "very close" to 
the line.
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Customization:

 .bas template command *FileId to provide the channel of the calculation file to a tcl 
procedure to directly print data.
 GiD_File fopen|fclose|fprintf|list command to allow print data from tcl in the calculation 
file opened from a .bas template
 GiD_EntitiesGroups get , new options:
-count to get only the number of objects instead of its list.

-element_type <types_allowed>: to filter the types of elements to be taken into account 
 GiD_Groups edit|get, new 'state' option with possible values: normal, disabled, hidden
 new function gid_themes::GetImageModule, retrieve images from module according to 
GiD theme, more info on customization manual.
 Fixed bug overwitting .spd file when using 'Save as' (current file get from memory data 
was overwritten with old .spd disk file)

1.1.10 From v 11.1.0d to 11.1.1d

What's new from version 11.1.0d to 11.1.1d

Preprocessing:

 Native groups.
 Dimensions: allow create a Radius dimension in mesh view setting three coordinates.
 Fixed some bug concerning semi-structured volumes when checking topological 
compatibilities before meshing.
Layers window: is no more restricted to be opened in preprocess integrated in the main 
graphical window
 Octree volume mesher ready to be used from MeshFromBoundary option. Option to set 
a maximum angle to consider sharp edges (MaxAngleSharpEdges).
 Several bugs fixed in octree volume mesher.

Postprocessing:

Isosurfaces and Streams:  corrected bug which reset iso+stream visualization styles 
when Geometry --> NoResult was selected.
Isosurfaces:  transparency factor of monochrome isosurfaces can be changed with 
Geometry --> Options --> Iso surfaces --> Change color.
Display Style window: now the layers window can be opened when it's integrated in the 
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main graphical window.
Several results:  corrected problem which caused color artifacts when drawing c.fill, 
vectors with colour depending on the vector's modulus and several isosurfaces with their 
own result's colour.
Isosurfaces: corrected problem related to empty legend window when they were placed 
outside the main window.
Display matrix vectors ( stresses):  corrected bug which caused to draw only the X 
component of the Si  main stress vector in render normal  mode. In render flat  and 
render smooth modes, stress vectors were drawn correctly though.
Labels:  labels are drawn a little bit nicer and smarter, i.e., GiD tries to place labels in 
one of four positions, where the label is less occluded by the model. 
Spheres and circles: corrected bug when merging files with spheres or circles.
Quadrilaterals and VertexArray and Vertex Buffer Objects: now quads are drawn as 4 
triangles, as with Display List draw mode.

Customization:

 GiD-Tcl event proc AfterProcess { words is_rotation } , to able send GiD commands 
from a master to a slave 
 GiD-Tcl commands:

 GiD_Groups create|delete|edit|get|list|window|exists|draw|end_draw
 edit rename|color|visible|allowed_types|parent <group> <value>
 get color|visible|allowed_types|num_entities|num_conditions|id|parent <group>

 GiD_EntitiesGroups assign|unassign|get <group> <over> <selection> or 
GiD_EntitiesGroups entity_groups <over> <entity_id>

      (over: points|lines|surfaces|volumes|nodes|elements|faces|all_geometry|all_mesh)

 GiD_Info conditions ovgroup, GiD_Info conditions $condname 
groupallow|condmeshtype|canrepeat 

 .cnd file: Conditions 'over groups' and special field GROUPALLOW to restrict allowed 
categories of enties of the group: points lines surfaces volumes nodes elements faces
 New .bas template commands related to groups (see Dump.bas example template) :

*loop groups, *groupnum, *groupfullname, *groupname, *groupcolorrgb, 
*groupparentnum, 
*set group *GroupName *nodes, *GroupNumEntities,*loop nodes *onlyingroup
*set group *GroupName *elems, *loop elems *onlyingroup
*set group *GroupName *faces, *loop faces *onlyingroup, 
*faceelemsnum:*faceindex

 New .bas template commands related to conditions over groups:
*loop conditions *groups, *loop groups *onlyincond, *groupnum *groupname

GiDPost library + GiD: the GiD_FlushPostFile command ensures that the last result is 
flushed to the postprocess file so that gid can read it completly and only complain about 
the incomplete file.

General:

Labels: now labels are shown when they are selected and not after pressing the 'escape' 
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key.
 Fixed some bug when using remote calculation.
Calculate in Linux: now the line ending of the first line in the .unix.bat file is checked 
and issues an error if it looks like a ms windows one.
PostScript ( ps, eps), pdf,svg: added gl2ps library, by C. Geuzaine, which 

 improved size of vectorial postcripts ( x4 in size reduction), 
 adds new output formats: svg ( scalable vector graphics), pdf ( portable document 
format).

when generating vectorial images ( ps, pdf, pgf, svg) contour fills are drawn without 
textures, drawing method is changed to display lists and after the image is generated, 
their state is restores back.
Vectorial prints ( ps, eps, svg, pdf): comments and legend are ensured to be drawn over 
the model.
Drawing Zoom factor: now the zoom factor is shown just under the axes. Zoom 
frame set the zoom factor to 1x. When a project or a postprocess model is opened, the 
readed view is also used as zoom factor 1x, but the next zoom frame will be zoom factor 
to 1x. The showing of the zoom factor can be disabled through the right menu option ( 
or command line commands) Utilities --> Variables --> ShowZoomFactor .

1.1.11 From v 11 to 11.1.0d

What's new from version 11 to 11.1.0d

Preprocessing:

Geometry:

 Conditions window: allow list values of applied conditions along all intervals.
 Creation of NURBS line as curve u or v constant on a NURBS surface.
 Creation of points specifying u and v on a parametric surface.

Mesh

 Octree volume mesher
 Draw grid on cartesian mesh.
 Variable AlignSemiStructuredNodes to force the semi-structured volumes to have 
the structured nodes aligned.

Postprocessing:

 new simplification mode for visualizing huge meshes. at the moment only geometric 
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criteria is used. c.fill and display vectors can be drawn over this simplified mesh. 
 Post state also saves cut between sessions.
 Faster vectors drawing in render mode, corrected " options --> vector--> draw all 
vectors " option
 more integrate vector options to appear in graph window
 Enabled quick internal texture drawing method with display style nodes and 
nodes+boundary now, selectable through Options --> Geometry --> point options
 Legends: same look for linux and ms windows.

Customization:

 Condition with locals axes field #LA#, new kind of 'automatic main' #M# axes for 
surfaces using its main curvature directions if they can be defined.
 Plugins: GDAL 1.1 allow convert raster file into Arc/Info grid ASCII file.
 Problemtype Ansys, added function to import mesh of hexahedra from Ansys file.
dev_kit / GidUtils: new gidutils functions:

 GidUtils::TransformScreenToWorld { scr_x scr_y} # transforms screen coordinates 
to world coordinates
 GidUtils::PickWorldPoint { { WarnLineMsg ""}} # waits for the user to picka world 
point

Fixed bugs:

General:

 Fixed problem when taking JPG snapshots.
 Fixed bug: now 'gid -help' prints help in the linux console.
 Fixed bug with tooltips which caused to draw a very long single line.
 Fixed problem when taking snapshots with the 'take snapshot' icon

Preprocessing:

Geometry:

 Fixed bug in geometry from mesh option.
 Avoid error messages directly printed to stdout when trying to open a jpeg 
file (e.g. background image)
 Surface division: fixed bug that join close points of the surface

Mesh:

 Fixed bug in semi-structured volumes meshing.
 Fixed bug in RSurf unstructured surface mesher.
 Fixed bug in meshing advance bar.
 Fixed bug in unstructured quadrilateral mesher.
 Fixed normal orientation on faces of prisms for vertex buffer objects drawing 
method.
 Fixed several configurations where Tetgen crash.
 Fixed bug in cartesian mesher for non-uniform meshes

Postprocessing:
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 Fixed bug when drawing transparencies in normal render, i.e. without 
ilumination, which caused to draw the mesh too dark.
 Fixed bug when taking PNG snapshots of displayed vector results, also 
stresses and complex vectors, which caused to draw vectors and legends 
somewhat transparent, and looked too light.
 Corrected bug when results cache was activated and cuts were converted to 
full featured sets ( Do cuts --> convert cuts to sets), when interpolating the 
new results, the original were not retrieved from disk.
 Fixed problem with which the user could not abort reading multiple files.
 Fixed problem which caused gid to crash with vertex buffer objects and 
some complex visualization combinations.
 Fixed problem when exporting PLY: now the number of faces is checked to 
avoid writing empty ply files, only surface meshes and cuts converted to 
sets are exported.
 Fixed problem when exporting cuts: avoids writing of empty files.
 Fixed problem with graphs, which added '_' in names.
 Fixed bug when doing a contour fill which caused to change the 'Point' 
visualization style.
 Fixed problems with the thousand separator in numbers.
 Fixed problem then creating a Do cuts --> cut wire which could not be created 
when the 'draw interior elements' is disabled for a surface mesh.
 Fixed problem when selecting points for cuts, graphs, etc., on large 
dimensioned models.
 Fixed problem with which sometimes nodes could not be labeled.

 Created meshes inherits settings from parent meshes in following 
operations:
 separating connected components,
 extracting boundaries,
 joining sets or volumes,
 dividing by selection,
 ...

Graphs: when doing several integrals, only the first message is displayed in a 
window, the rest is showed at the command line.
Integrals: When doing integrals, values are no more displayed in a window.
Stream lines & line size: ensure line size is not 0.0.
Point visualization style:  the Options --> Geometry --> point option  'internal 
texture' can also be used with this style to speed-up drawing with a nice 
look.
Importing cut planes: import all cut planes by default, the user is no longer 
asked.
 Fixed problems reading automatically view when changing to postprocess.
 Fixed errors when changing line size drawing value.
 Fixed bug drawing graphs while the model was in perspective mode.
Merging multiple files: corrected problem when merging parts of meshes when 
there are different meshes at different steps
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Smooth contour fill: only smooth nodal results for the meshes where the gauss 
points, and their results, are defined.
Several Results + Contour Fills with Gauss Points results: corrected problem when 
doing several c.fill with different results on gauss points, which caused 
previous applied contour fills to be corrupted.

Customization:

 Fixed bugs in chinese messages catalog that crash GiD using this language.
 Units: fixed bug converting degrees Kelvin <-> celsius.
 Hdf5 package: fixed bug writting sets of strings without compression.

 Plugins:
 EMA3D 1.1 import also ISOTROPIC BODY and NEW THIN WIRE 
entities.
 GDAL 1.1 allow convert raster file into Arc/Info grid ASCII file.
 Amelet 1.20 fixed bug exporting isolated nodes of cartesian mesh.

 Automatically update menus when special Tcl variable 
::GidPriv(PostSpaceDimension) change.
 GiD_Mesh: refresh mesh to visually see changes in VBO and VA visualization 
modes.
 GiDCustomHelp find html help on the folder appropiated for the current 
language.

1.2 Detailed changes of 11.0.x official releases

1.2.1 From v 11.0.7 to 11.0.8

General:

USB linux passwords: now passwords registered using USB memory sticks are 
recognized on Ubuntu 13.04 and Fedora 18 ( linux kernel >= 3.8).

1.2.2 From v 11.0.6 to 11.0.7
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General:

Gif No dithering:  corrected crash when taking snapshot with this format and there are 
more than 256 colours on screen.

Preprocessing:

Fixed some bugs of layers
Corrected bug converting a planar surface to NURBS expression
Fixed error when using drag and drop of a mesh file (stl, 3ds, nas, etc) is a previous 
mesh exists

Postprocessing:

Results animation:
 corrected problem with which user defined limits were not hold when doing 
animation of several results.
 verify only user specified step in the from: and to: entries when doing animation of a 
deformation of an analysis and c.fill of another one.
iso-surfaces with contour fill:  now the animation of these two combined result 
visualization can be done without the 'several results' option.

Several files:  corrected problem when several files were read and the list was not 
sorted.
Animating smooth contour fill:  corrected crash when fixing global limits when several 
meshes are used at different time steps.
Animation:  corrected contour limits problem when changing result visualization in the 
middle of an animation and rewind it.
Isosurfaces:  corrected crash when converting isosurfaces to cut meshes when no 
surface was there.

Customization:

Transform: enhanced to preserve the material's books

1.2.3 From v 11.0.5 to 11.0.6
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What's new from version 11.0.5 to 11.0.6

General:

Selection lines by software ( emulate front buffer): corrected problem when GiD window 
is very big on modest graphic cards or using GiD in 'safe mode', or gidx.
MS Windows 64:  corrected problem with progress bar and results cache when reading 
files with size > 2GB.

Postprocessing:

Display vectors:  corrected drawing error when drawing as vectors a component of a 
resullt vector with fixed size vectors.
Isosurfaces: corrected isosurface style problems, when it's bad defined --> set at least 
body visualization of isosurfaces.
Several Meshes: corrected problem with several meshes with different number of layers 
at each time step, when animation a deformation and a contour fill.

1.2.4 From v 11.0.4 to 11.0.5

What's new from version 11.0.4 to 11.0.5

General:

Linux sysinfo number: now the same local sysinfo number ( i.e. usb and floating sysinfo 
remains the same) is shown when the users upgrades to Ubuntu 13.04 .
High-resolution pictures: corrected problem which arised on Intel graphics and on Linux.
Initial configuration window: better size for smaller displays.
Several minor errors corrected.

Preprocessing:
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Drawing normals: corrected problem in which the normals drawn where not correctly 
update when normals were swaped.
Avoid crashing when contactvolume is wrong oriented

Postprocessing:

Several results:  corrected problem when deleting all result's views which caused to 
disappear analysis, steps and results entries on menus.
Graphs: corrected problem when clearing graphs or switching between graph's view and 
result's view which caused sometimes that GiD exited.
Graphs: corrected problems related to graphs labels.

Customization:

 Fxed bug loading a *.sim symbols empty file.

1.2.5 From v 11.0.3 to 11.0.4

What's new from version 11.0.3 to 11.0.4

General:

Spheres + VBO:  added memory limit when drawing thousands of spheres with high 
detail level. If limit is reached, then the detail level is lowered. At detail level 0, spheres 
are drawn as points. The memory limit is set to 1 GB, which implies that up to 120 
thousand spheres can be drawn with a nice detail level (n.d.l.) of 9, i.e. ~320 triangles 
per sphere, 150 thousand spheres up to n.d.l. 8 ( 250 triangles), ..., 560 thousand up to 
n.d.l. 4 ( 64 triangles). 

Preprocessing:

Avoid bug using quadratic mesh from preferences instead of the model's value
Refresh mesh to show changes when creating a mesh connecting points

Postprocessing:

Stream lines: better calculation of initial time step to create stream lines.
The labels are properly showed in graphs with logarithmic scale
Fixed bug reading ComplexScalar results
Fixed bug inverting line graphs
Fixed bug labeling graph nodes
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Customization:

 Amelet import, fixed bug: avoid layer without its parent layer

1.2.6 From v 11.0.2 to 11.0.3

What's new from version 11.0.2 to 11.0.3

General:

Linux: some redraws avoided when a tooltip or a menu is displayed over the graphical 
window
command line flag -noredirect -> do not redirect standard error nor standard output
avoid lock if there are connection problems when checking for new versions.

Preprocessing:

 Fixed bug numbering nodes of sphere mesh elements
 Fixed bug calculating volume bounded by trimmed closed surfaces.

Postprocessing:

 Fixed bug using deformation scale: when factor was 0 the results were not shown
line graphs: corrected bug for line-graphs when triangles are aligned and "very close" to 
the line.

Customization:

 .spd 'specific problemtype data' file not overwritten when using 'save as'
 Avoid raising some window error messages when meshing from boundary
 Allowed Altair licence for Click2Cast problemtype

1.2.7 From v 11.0.1 to 11.0.2
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What's new from version 11.0.1 to 11.0.2

General:

Snapshots: Added gl2ps library ( by C. Geuzaine):
smaller vectorial PS files
new formats: vectorial PDF, SVG and PGF formats.

Grey images: Corrected problem with grey images when they were used as textures or 
backgrounds.
Show error message if it is not possible to save the password in disk, and explain 
possible solutions.
Fixed bug drawing text in front buffer with OpenGL by software and 'emulate front 
buffer' enabled (e.g. showing for axes "w x y" instead "x y z")
Saved and restored in preferences the option of transparent background on captured 
images

Preprocessing:

Variable AlignSemiStructuredNodes to force the semi-structured volumes to have the 
structured nodes aligned.
Fixed some bug concerning semi-structured volumes when checking topological 
compatibilities before meshing.
Layers window: is no more restricted to be opened in preprocess integrated in the main 
graphical window
Faster calculation of points and derivatives on NURBS
Fixed crash exporting Rhino models with surfaces with wrong render mesh without any 
element
Fixed crash writting PS vectorial images in preprocess.

Postprocessing:

Smooth contour fill: only smooth nodal results for the meshes where the gauss points, 
and their results, are defined.
Several Results + Contour Fills with Gauss Points results: corrected problem when doing 
several c.fill with different results on gauss points, which caused previous applied 
contour fills to be corrupted.
Several results:  corrected problem which caused color artifacts when drawing c.fill, 
vectors with colour depending on the vector's modulus and several isosurfaces with their 
own result's colour.
Isosurfaces and Streams:  corrected bug which reset iso+stream visualization styles 
when Geometry-->NoResult was selected.
Isosurfaces: corrected problem related to empty legend window when they were placed 
outside the main window.
Display Style window: now the layers window can be opened when it's integrated in the 
main graphical window.
Faster vectors  drawing in render mode, corrected " options --> vector--> draw all 
vectors " option
Display matrix vectors ( stresses):  corrected bug which caused to draw only the X 
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component of the Si  main stress vector in render normal  mode. In render flat  and 
render smooth modes, stress vectors were drawn correctly though.
Spheres and circles: corrected bug when merging files with spheres or circles.
Labels of results:  corrected problem which appeared sometimes with labels of results, 
when the timestep was changed the label of the result change to label of node number.
Textures:  when applying textures, if the render mode is vertex array or vertex buffer 
object, it is changed to display lists, because textures mapped on meshes are still not 
supported in va/vbo mode.
Textures --> ScreenMap: if GeoReference information is present, it can be shown and 
used to project the image to the mesh, f.i. applying terrain images to a terrain mesh.
Textures: corrected problems: when changing mesh style, texture now remains on; and 
when applying a texture, draw no results ( c.fill & co) --> c.fill hides texture
Results: corrected bug when result's name is > 100.
Reading TIFFs: ( for textures or background) support for tiff using colour maps and 
inverse black-white maps.
Dimensions: Allow creation of dimension-radius in postprocess, asking for 3 points 
instead of a arc-curve than not exists in post
Graphs: Fixed bug cutting hexahedra to create a line-graph (only graph points were 
created, without lines connecting them)
Graphs: Fixed bug that display labels on all graph points instead the selected ones

Customization:

Vtk import plugin: avoided bug opening filenames with non-ASCII characters

1.2.8 From v 11 to 11.0.1

What's new from version 11 to 11.0.1

General:

 Fixed problem when taking JPG snapshots.
 Fixed bug: now 'gid -help' prints help in the linux console.
 Fixed bug with tooltips which caused to draw a very long single line.
 Fixed problem when taking snapshots with the 'take snapshot' icon

Preprocessing:

Geometry:
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 Fixed bug in geometry from mesh option.
 Avoid error messages directly printed to stdout when trying to open a jpeg file (e.g. 
background image)
 Surface division: fixed bug that join close points of the surface

Mesh:

 Fixed bug in semi-structured volumes meshing.
 Fixed bug in RSurf unstructured surface mesher.
 Fixed bug in meshing advance bar.
 Fixed bug in unstructured quadrilateral mesher.
 Fixed normal orientation on faces of prisms for vertex buffer objects drawing method.
 Fixed several configurations where Tetgen crash.
 Fixed bug in cartesian mesher for non-uniform meshes

Postprocessing:

 Fixed bug when drawing transparencies in normal render, i.e. without ilumination, 
which caused to draw the mesh too dark.
 Fixed bug when taking PNG snapshots of displayed vector results, also stresses and 
complex vectors, which caused to draw vectors and legends somewhat transparent, and 
looked too light.
 Corrected bug when results cache  was activated and cuts were converted to full 
featured sets ( Do cuts --> convert cuts to sets), when interpolating the new results, the 
original were not retrieved from disk.
 Fixed problem with which the user could not abort reading multiple files.
 Fixed problem which caused gid to crash with vertex buffer objects and some complex 
visualization combinations.
 Fixed problem when exporting PLY: now the number of faces is checked to avoid writing 
empty ply files, only surface meshes and cuts converted to sets are exported.
 Fixed problem when exporting cuts: avoids writing of empty files.
 Fixed problem with graphs, which added '_' in names.
 Fixed bug when doing a contour fill which caused to change the 'Point' visualization 
style.
 Fixed problems with the thousand separator in numbers.
 Fixed problem then creating a Do cuts --> cut wire  which could not be created when 
the 'draw interior elements' is disabled for a surface mesh.
 Fixed problem when selecting points for cuts, graphs, etc., on large dimensioned 
models.
 Fixed problem with which sometimes nodes could not be labeled.
 Created meshes inherits settings from parent meshes in following operations:

 separating connected components,
 extracting boundaries,
 joining sets or volumes,
 dividing by selection,
 ...

Graphs: when doing several integrals, only the first message is displayed in a window, 
the rest is showed at the command line.
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Integrals: When doing integrals, values are no more displayed in a window.
Stream lines & line size: ensure line size is not 0.0.
Point visualization style: the Options --> Geometry --> point option  'internal texture' 
can also be used with this style to speed-up drawing with a nice look.
Importing cut planes: import all cut planes by default, the user is no longer asked.
 Fixed problems reading automatically view when changing to postprocess.
 Fixed errors when changing line size drawing value.
 Fixed bug drawing graphs while the model was in perspective mode.
Merging multiple files: corrected problem when merging parts of meshes when there are 
different meshes at different steps

Customization:

 Fixed bugs in chinese messages catalog that crash GiD using this language.
 Units: fixed bug converting degrees Kelvin <-> celsius.
 Hdf5 package: fixed bug writting sets of strings without compression.
 Plugins:

 EMA3D 1.1 import also ISOTROPIC BODY and NEW THIN WIRE entities.
 GDAL 1.1 allow convert raster file into Arc/Info grid ASCII file.
 Amelet 1.20 fixed bug exporting isolated nodes of cartesian mesh.

 Automatically update menus when special Tcl variable ::GidPriv(PostSpaceDimension) 
change.
 GiD_Mesh: refresh mesh to visually see changes in VBO and VA visualization modes.
 GiDCustomHelp find html help on the folder appropiated for the current language.
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37

Main news from version 10 to version 11. (See Detailed news from 10 to 11 -pag. 41- for 
the full list of news).

General

 Ttk themed windows (experimental 'Dark GiD theme' and 'Classic theme')

Classic theme window
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Dark theme window

 Faster drawing using advanced OpenGL features (Vertex arrays and Vertex buffer 
objects) and textures
 Plugins: new postprocess import plugins: PLY, OFF and OBJ formats
 OffScreen: to run GiD in background with graphic features without any window (.e.g. to 
create images in batch mode)
 Sphere and circle element support enhanced: draw as texture and more generation 
options
 Ground plane: can be used as floor (shadows are drawn on it) or as mirror (window 
View->Advanced viewing settings..)
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Ground plane with mirror effect

 Automatic check if a new version is available when starting GiD.

Preprocessing

 Tetgen volume mesher inside GiD, based on Delaunay algorithm.
 Meshing in parallel. The volumes can be meshed in parallel using the number of threads 
wanted by the user (set at Preferences->General).
 Join volumes for geometric edition, and join surfaces preserve applied conditions.
 Edit NURBS: conversion to Bezier form for curves and surfaces.
 Draw curvature of curves by colors.
 Cartesian volume mesh with non-uniform grid spacing, size ratio, settings in 
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preferences window and support of cartesian 'face' and 'edge' elements.
 Draw higherentity on mesh edges. (View->Higher Entities->Edge).
 Structured lines: allow to assign real size to set the equivalent number of cells.
 Option for manual creation of nodes and elements.
 GDAL plugin to import GIS files as geometric or mesh entities.
 EMA3D plugin to import cartesian meshes generated by CADfix
 STAR-CD plugin to import STAR-CD meshes
 Improvements in most meshers: rfast, rsurf, semi-structured, boundary layer, 
quadrilateral mesher, etc.

Postprocessing

 Results cache: Avoid load all results simultaneously in memory, and allow set maximum 
memory to be used.

Node tracing: Draw of the path followed by a node in along time steps.
 Saving postprocess state (isosurfaces, stream lines and view information is saved 
between sessions).
 Integral: more options available in numerical integration of results.
 Creation of boundary mesh of currently visualized mesh.
 Separate connected parts in different sets.
 Render: Added two new fixed lights (switchable separately).
 Results support complex numbers: ComplexScalar and ComplexVector.

 Animation: new Macromedia Flash Video (.flv) export format.
 Create Results: added more operators (sqrt, log10, db10, db20, abs, exp, inverse, 
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dFT).
Creation of statistical result calculating the minimum, maximum, average or the 
standard deviation of other result.
 Create Graphs window: to create a graph applying some operator to another graph.
 Read of postprocess files with GiD postprocess HDF5 format written by the GiDPost 
library, and files with Amelet HDF5 format.
 Contour Fill/Contour ranges: option to display the range just under the cursor.
 VTK plugin to import mesh and results.
 PDF output: now outputs images in pdf format.
 PLY export: shown meshes and current nodal result can be exported in the Polygon File 
Format, aka. Stanford Triangle Format.
 Improvements in several algorityms: stream lines, etc.

Customization

 GiD dynamic library plug-in mechanism to load/unload dynamic libraries (developed an 
interface to create posprocess mesh and nodal results).
 New GiD-Tcl commands:

 GiD_Geometry now allow also create and ask for contactsurface and contactvolume 
and to list the problematic unrendered surfaces.
 GiD_Cartesian to get and set cartesian grid properties.
 GiD_BackgroundImage to handle background image.
 GiD_MeshPost to create and inquire postprocess mesh.
 GiD_Result, new 'gauss_point' and 'result_ranges_table' sub-commmands to 
manage them.
 GiD_Graph to handle postprocess graphs.

 Tcl-GiD events: 
 New events AfterCreateMaterial, AfterRenameMaterial, BeforeDeleteMaterial, 
AfterChangeMaterial, AfterAssignMaterial, BeforeMeshErrors, BeforeResultReadErrors.
 GiD_Info events: to know the full list of raised events.

 Global Tcl variables: 
 GidPriv(HideQuadraticTypeLevel) to disable quadratic options .
 GidPriv(PostSpaceDimension) to disable 3D results.

 Tcl packages:
 GDAL Tcl package to read/write GIS digital terrain models from multiple formats 
(Arc/Info, tiff and most image formats ,etc).
 Vtk Tcl package to wrap vtk functionality.

2.1 Detailed news from 10 to 11
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General

 Faster drawing using advanced OpenGL features
 Use of Open GL's Vertex Arrays and Vertex Buffer Objects. Utilities --> Variables --> 
OGL_useMeshObjects values:

 OGL_useMeshObjects = 0 --> draw using immediate mode
 slow, no extra memory, 

 safe & quick graphic mode, works always
 OGL_useMeshObjects = 1 --> draw using Display Lists 

 quick, uses memory to create objects, 
 safe & quick graphic mode, works always, 

 limited number of elements
 OGL_useMeshObjects = 2 --> draw using Vertex Arrays
 quick, uses less memory than Display Lists, 

 safe & quick graphic mode, works always, 
 better suited for Software mode and Intel graphics cards

 OGL_useMeshObjects = 3 --> draw using Vertex Buffer Objects
 quick, uses less memory than Display Lists but more than Vertex 
Arrays, 
 safe & quick graphic mode, OpenGL 1.5 required, 

 better using a graphic card
 More, and bigger, bitmap fonts for PGF's PmFont style.
 Colours: changed first default color in pre (Layer0) and postprocess, corrected 
automatic color change/reset.

 Plugins: New import plugins (mesh and results): PLY format, OFF format, added a tcl 
progress bar in ply plug-in
 Plugins: Automatic load of plugins under Files --> Import --> Plugins, of the dynamic 
libraries located in $GID/plugins/Import/.../NamePlugIn/NamePlugIn.dll (or .so)
 VA / VBO: improvements and bugs corrected in VBO / VA visualization mode, in pre and 
in postprocess mode.
 Plugins: added new function: GiD_GetTclInterpreter so the GiD's tcl interpreter can be 
used inside the client plug-in, PLY + progressbar example added.

 Page Setup window with information about the dimension of the image to be generated 
(in mm/inches and pixels).



43Detailed news from 10 to 11

 OffScreen: added ofscreen support for MS Windows and Linux, so that GiD can work in 
background (or batch queue), for instance to create long animations or a series of 
snapshots.
 OffScreen: added button in the Animation Window to create a batch file to be used with 
GiD in background or batch mode.

 Linux + ATI drivers: workaround to the problem which caused GiD to lock just after 
saving project or image with 'selection lines by software (emulation front buffer)' on.
Problemtypes Abaqus, Ls-Dyna and Nastran updated to use floating PasServer licences

Linux + usb: better usb checking.
 Now the splash window shows the packages being loaded at start time. Can be 
switched off in ConfigureProgram.tcl
 Spheres + internal texture: brighter texture when drawing spheres in this mode and in 
without light (render normal).
 New ground plane: can be used as floor (shadows are drawn on it) or as mirror.
 New mirror effect: the model is mirrored on a ground surface with the window View --> 
Other viewing effects..



44Detailed news from 10 to 11

 Create results and graphs: layout rearranged and tool tips added.
 Backup: a version will only recover a backup if it was written by its exact GiD version, 
not from other GiDs.
 Some widgets have been updated to Ttk style.
 Now GiD checks if there is a new version available.
 User colour map, for contour fills for instance, are named and saved between sessions.
 Stream lines: can be exported and imported (in the same model), new command to 
delete all stream lines at once.
 Post Result State: now stream lines are saved between sessions.
 Ttk themed windows (experimental 'Dark GiD theme' and 'Classic theme')

Ask the user for theme 'classic' or 'black' when starting the first time.
Snapshot: all image formats have been merged into a single "write image file dialog", 
where the user can choose the format by selecting the apropiate filter or entering the 
corresponding extension.
Views:  new Utilities -> Variables -> ReadViewWithModel variable to disable reading 
views when a project is read in pre or a model is read in post.
 Macros icons can be selected from themed GiD icons, or import an image file that will 
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be converted to the current toolbar button size.

Preprocessing

 Join surfaces: transfer conditions to the joined entities
 Cartesian mesh with non-uniform grid spacing and settings in preferences window

 Improvements in advancing front volume mesher (tetrahedra).
 In 3D boundary layer mesh generation, improved the way of deciding when to stop 
shifting a node, depending on the proximity of the close nodes in the isotropic mesh.

 New option: DontDrawNormals/DrawNormals in Utilities --> SwapNormals to avoid 
draw the normals when there are a lot of surfaces, or when the process is automatized, 
for instance, in a macro.
 Quadratic type of the model (variable IsQuadratic) loaded automatically when the 
model is loaded.
 Support for Vertex Arrays and Vertex Buffer Objects so that the drawing of lots of 
surfaces (in flat or smooth render mode) and meshes (in any render mode) is faster.
 Initial green color for Layer0 has been changed to grey.

 Join volumes for geometric edition
 Edge Collapsing in triangles mesh. If the normals of selected elements are not 
coherent, now GiD make them coherent in order to be able to detect the sharp edges of 
the mesh.
 Added option to draw higherentity on mesh edges. (View->Higher Entities->Edges)
 Default element type in semi-structured volumes is tetrahedra (before, it was prism).
 Improvements in render mesh.

 Cartesian mesher: added SizeRatio option and removed WeightStart/End
 Cartesian mesher: support to read cartesian 'face' and 'edge' elements (Amelet format)
 Structured lines: if ndivisions is zero (default), now the number of cells equivalent to 
the unstructured size is assigned. In previous versions 2 divisions were applied.
Improvements in unstructured size transition regarding volume unstructured mesher.
Improvements in the smoothing with HighGeom option (trying to minimize the chordal 
error in surface meshes).
Correct sizes operations before meshing are faster because of improvements.

Option for manual creation of nodes and elements.
ACIS import updated until version 20.
Improvements in quadrilateral unstructured mesher.
 Visualization: VA + VBO mode, now the colour of the mesh can be coloured by layer or 
with a single colour (dark green) through the preferences window.
 Mesh generation: now the final message tells the user if the generated mesh is 
quadratic or not.
Improvements in RSurf and RJump surface mesher.
 Visualization: Inmediate mode, now the colour of the mesh can be coloured by layer or 
with a single colour through the preferences window.
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 Edit NURBS: conversion to Bezier form for curves and surfaces.

 Boundary layer mesher is faster.
 VA + VBO: now circles and spheres are drawn
 Modification of hierarchy of layers, now parent layers exists explicitly. The layer tree 
information is imported now from Rhino files.
 Selection of entities filtering subtypes: e.g. to assign a condition defined over volumes - 
over face elements only to surfacic elements
 Draw curvature of curves by colors.
 Improvements in surface meshing when chordalerror is assigned in meshing 
preferences.

 New Delaunay volume mesher using Tetgen.
 Option to mesh inner part of unstructured volumes with structured mesh (faster).
 Mesh from boundary: new option to fit or not the surface boundary, allowing refinement 
(now for Tetgen only)
 Improvement in the automatic detection of Master surface in semi-structured volumes.
 Improvement in final mesh quality in unstructured quadrilateral meshes.
 Improvements in semi-structured volume mesher.
 Labels + ATI cards: corrected bug displaying labels with the latest catalyst driver.

Meshing in parallel. The volumes can be meshed in parallel using the number of threads 
wanted by the user (set at Preferences->General).
Rball sphere/circle mesher updated.
VA, VBO:  less memory required to get unique lines when drawing meshes in normal 
render mode. corrected problem with quadratic elements.

Postprocessing

 Postprocess state: now saves and reads isosurfaces information.
 Stream lines: faster location of elements when a stream line is created.

 Postprocess state: now saves and reads stereo and shadow information.
 Integral: New option in Integral calculation: '2D' mode, in order to do vector integration 
over lines in 2D (normal of line = vector( Node0, Node1) ^ Vector( 0, 0, 1))
 Preferences: new panel for Postprocess options:

 Draw method: immediate mode, display lists, vertex arrays or vertex buffer objects
 Enable or disable use of textures to draw Contour Fills
 Enable or disable 'Results cache': ( Linux, Mac OS X) uses a portion of the main 
memory as 'cache' of results so that not all the results are loaded into GiD. The 
amount of main memory to be used can also be specified. 

 Graphs: Point evolution and integral graphs bugs corrected. Now works also for 1 Gauss 
Point per element.
 Graphs: Integral works also for 1 Gauss Point per element.
 Graphs: new option to show the values of a graph into a table window.

 New option: Options --> Geometry --> Extract boundaries from shown volume and 
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surface meshes; for each mesh creates a set with its boundary elements. The original 
mesh is left untouched.
 New option: Options --> Geometry --> Separate connected components from shown 
volume and surface meshes; for each mesh detects groups of connected elements and 
stores them in separate sets. For instance a single volume mesh which corresponds to 
three unconnected spheres will be separated into three sets each one containing the 
volume elements of a single sphere. The original mesh is left untouched. By default a 
maximum of 50 connected groups will be separated into separated sets. This limit can 
be modified with the variable Utilities --> Variables --> PostMaxNumComponents on the 
main's window the right menu.
 Display Window can be integrated into GiD's main window
 PGF Fonts: now True Type fonts are also used in Mac OS X, thanks to free type library 
actualization

 Read State: when the state is read and all meshes were off, now all are siwtched on.
 Results cache: now works in MS Windows
 Results cache: when reading a big file, lasts steps remain in memory ( so many as 
memory pool specified by the user).
 Graphs: problems corrected related to title, point style visualization ( disconected node 
graph), repeated names.
 Selection in post improved.
 New PostProgressBar: using the 'tile' progress bar in postprocess, allows indeterminate 
progress too.

 Line graph: added option to use the x, y or z coordinates as 'x' axis, besides the already 
existant 'line variation' option.
 Create result window can mix results between different analysis and time steps
 Results cache & Merge: check if some files uses mesh 'Group's and some no, issue an 
error if so.
 Render: Added two new fixed lights ( switchable separately): one orange and another 
blue, accesible throught the right mouse button menu.

 Health check: added option to filter outlier vertices, for instance, to filter out vertices 
with coordinates bigger than 1e+32.
 Mesh read: for line elements, accept 'line' keyword ad element type in the mesh 
description line, besides the old keyword 'linear'.

 Animation Window: rewind button puts slider at the user selected starting step, and not 
the first step of the analysis.

 New results types:
 ComplexScalar: results with two components: real and imaginary part --> a + b · 
i

 ComplexVector: vectors with six components: ( rX + iX, rY + iY, rZ + iZ). If 
not provided, GiD will calculate the modulus of the real part ( sqrt( rX^2 + 
rY^2 + rZ^2), of the imaginary part ( sqrt( iX^2 + iY^2 + iZ^2) and of the 
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whole vector ( sqrt( rX^2 + rY^2 + rZ^2 + iX^2 + iY^2 + iZ^2)
 DisplayVectors visualization draws both parts ( real and imaginary) when 
the modulus of the whole vector is selected

 LineDiagram draws both parts ( real and imaginary) when the modulus 
of the whole vector is selected.

 Stream lines can be done on the real part ( field) of the complex 
vector or on the imaginary part ( field).
 Look at the customization and reference manuals to get more 
information on how to specify complex numbers for GiD.

 Animation: GiD now can save animations in a new format: Macromedia Flash Video 
(.flv)

 Labels: limited the maximum amount of labels to be displayed to 5.000.
 STL export: added option to select whether the quadrilaterals should be divided into 
two or four triangles
 Graphs: new Point Complex Evolution graph, similar to 'Point Evolution' but for complex 
results, where both real and imaginary part of the result are displayed as 'x' and 'y' in 
the graph.
 Icon bars: the contour options icons and the graphs icons have been grouped into two 
submenus, so the general view is less cluttered
 Stream Lines: creation options are more visible now: View results --> Stream lines --> 
Single point / Along line / In a quad(rilateral)
 Stream Lines: made the algorithm a bit faster for big meshes made and for the first 
stream line.
 Show Min Max: added 'show minimum', 'show maximum' and ' show min max' options 
which shows the minimum result alone, the maximum result alone or both at once.
 Contour Lines + VA / VBO: now contour lines are drawn in Vertex Array or Vertex 
Buffer Object mode.

 Display vectors: first time fixed size vectors is used, the minimum size is 8.
 results cache + several meshes: free results always except in the last meshgroup.
 Postscript vectorial mode: if model is 2D no triangle discretization is done and so, 
smaller files are created.
 GUI: added 'disable tooltips' preference
 Remote display ( Linux): disabled Vertex Array / Vertex Buffer Object in remote 
visualization which caused GiD to crash.

 Stream lines: faster search tree creation ( up to x4) for the first stream line.
 Post state: solved bug which caused mesh styles to be read wrong.
 Toolbar's buttons: now icons can be showed with short names or names alone.
 Tooltips can be: showed as always, disabled or displayed at the bottom of the main 
window.
 Import plug-in: added support for complex scalar and complex vector results, now they 
can be imported too.

 Spheres: support for VA and VBO for faster drawing of nice spheres.
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 Standard (internal) gauss points (GP_TRIANGLE_1, GP_QUADRILATERAL_4, ...) should 
not be explictly defined to be used.
 Delaunay: elements bigger than 10 times ( default) the mean size of elements are 
culled. Check Utilities --> Variables --> PostDelaunauCullBigElements to modify it.
 Macros: Added macro to create a result with the minimum, maximum or average value 
of a scalar for all steps.
 Create Results: added some single operator functions ( sqrt, log10, db10, db20, abs, 
exp, inverse (1/)) to Window-->Create Result...
 Graphs: new tcl command GiD_Graph
** GiD_Graph show --> shows the graphs
** GiD_Graph hide --> hides the graphs
** GiD_Graph list --> list the existant graphs
** GiD_Graph clear --> deletes all graphs
** GiD_Graph get <graph_name> --> gets the graph data of "graph_name", the same 
as the create data.
** GiD_Graph delete <graph_name> --> deletes the graph "graph_name" causing an 
error if does not exists
** GiD_Graph create <graph_name> <label_x> <label_y> <list_x_values> 
<list_y_values> <unit_x> <unit_y> --> creates the graph "graph_name" with the 
provided information, causing an error if the graph already exists.

 Graphs: added discrete Fourier Transform of a Graphs. Uses the y values as real part 
and 0 as the imaginary part for the fft transformation. The graph created will use an 
index for the x axis and the real, imaginary or module of the dft result as the y axis. 
Check Options-->Graphs-->dFT-->real , imaginary or module
 Graphs: added discrete Fourier Transform of a Graphs. Uses the x values as real part, 
and the y values as imaginary part for the fft transformation. The graph created will use 
an index for the x axis and the real, imaginary or module of the dft result as the y axis. 
Also the graph created can have as x axis the real part and as y axis the imaginary part 
of the dft result. Check Options-->Graphs-->dFT complex-->real , imaginary, module or 
complex
 Read of postprocess files with GiD postprocess HDF5 format written by the GiDPost 
library, and postprocess files with Amelet HDF5 format.
 Create Results: added option for operators +, -, * and / which now accepts a scalar or 
vector ( both can be complex) as second operand check the window: Window-->Create 
Result...
 Create Results: added operators sqrt, log10, db10, db20, abs, exp, inverse (1/) which 
operates on one result. Only operators +, -, * or  /  accept scalars,vectors 
or results as second operand. SqrtAbs, Abs, Log10Abs, Exp, 1/ requires a result as 
second operator.
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 New Create Graphs window: to create graphs from another ones, with following 
operators: +, -, *, /, sqrt, log10, db10, db20, abs, exp, inverse (1/), derivate, integral 
and fit. The "g1 fit g2" operator fits the bounding box of the second graph g2 to the 
bounding box of the graph g1. Also interpolador has been added: CubicSpline and 
Catmull-Rom Spline. Graphs can also be scaled and traslated in order to match another 
one. This is the new window, and below some interpolated graphs examples.



51Detailed news from 10 to 11

 Create Graphs: added dFT options:
 create graph( idx, dft.real) or dft( idx, dft.imaginary)

 sale y values according to the number of items
 get half the values, dft seems to be symmetric

 Integration graph: added tangencial and un projected vector integration for lines and 
2d
 Graphs: now, if the Amelet plugin is present, they can be exported to the Amelet HDF5 
format
 Label results: now labels of vectors, tensors and local axes displays a letter with the 
component's name.

 VA + VBO: now quadratic elements are drawn as several triangles / cuadrilaterals, 
instead of drawing them as linear elements if Utilities --> Preferences --> Graphical --> 
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DrawQuadraticElements is set to "As lines".
 New import of Vtk format mesh and results, implemented as an auxiliary plugin
Result surface  on Lines will draw them using the result as thickness, including 1gp 
results.

Contour Fill / Contour ranges: option to display the range just under the cursor.
Result surfaces: using this result visualization style on lines will draw lines with their 
thickness depending on the absolute value of the result. For nodal and 1 gauss point 
results.
Animation Window: make gif options more evident to the user, so that they can be 
selected more easily.

Edge colour: added new option to define the colour to be used to draw edges, instead of 
the default black colour ( Options --> Geometry --> Change edge colour...).
PDF output: now outputs images in pdf format. 
PLY export: shown meshes can also be exported in the Polygon File Format, aka. 
Stanford Triangle Format. Ascii and binary. Nodal results of current selected step are 
also written in the PLY file as nodal properties.
Statistical results: macro passed to Windows menu, which creates a statistical result: 
foreach node calculates the minimum, maximum, average or the standard deviation of 
all values, i.e. across all steps, of the selected result.
Node traces:  now traces of nodes can be drawn. For a single mesh for the whole 
analysis, the node will follow the path of the deformed mesh across all steps. When 
several meshes are used for several time steps, then the nodes can follow the track of 
the original mesh or from the deformed one.

Customization

 $GID/plugins folder, recursivelly load all tcl files with the same name as the folder. 
 GiD_Info group_entities
 GiD_Cartesian get|set ngridpoints|boxsize|corner|dimension|coordinates|iscartesian 
<values>
 Cartesian() GiD variables MinSizeMainGrid WeightStart WeightEnd GridUniform
 BeforeMeshGeneration GiD-Tcl event now stop the generation when returning -cancel-
 Tcl global variable ::GidPriv(PostSpaceDimension) to declare that our resuls is 2D (e.g. 
to integrate results in 2D projection)
 package hdf5 updated from 1.0 to 1.2 (-vtype string|char allow creation of sets of 
strings, and unsigned chars)
 package tablelist updated from 4.9.1 to 5.1

 New -elementtype and -higherentity options in GiD_Info layer command 
GiD_Info layer -entities elements -elementtype $type $layername1 $layername2 ...

GiD_Info layer -entities nodes -higherentity $num $layername1 $layername2 ...

 BeforeDeleteLayer event: if it returns -cancel- the layer deletion is cancelled.
 GiD_Geometry get/create now allow also contactsurface and contactvolume
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 New Tcl command GiD_BackgroundImage get|set show|filename|location <values>

 Conditions: added #WIDTH# option in the value description to specify the length, in 
characters, of the entry used by the user to enter the value of the condition (already in 
GiD 10.1.0d but not acknowledged). For instance: 

CONDITION: Volume_Vector_function

CONDTYPE: over volumes

CONDMESHTYPE: over nodes

HELP: Here you can define a function/expresion ...

QUESTION: Ux

VALUE: 0.0#WIDTH#(64)

END CONDITION

 Tcl events for materials: AfterCreateMaterial, AfterRenameMaterial, 
BeforeDeleteMaterial, AfterChangeMaterial.

 GDAL as Tcl package to read/write GIS digital terrain models from multiple formats 
(Arc/Info, tiff and most image formats ,etc)
 GDAL plugin using the previous package to import GIS files as geometric or mesh 
entities
 New Tcl-GiD event AfterAssignMaterial { name leveltype }
 hdf5 plugin updated to version 1.4
 verifp plugin updated to version 1.33
 GiD_MeshPost tcl command to create postprocess mesh
 Special self-updated field #FUNC#(NumPointToNumNode), to automatically convert the 
point number in a node number

GiD_MeshPost tcl function to create postprocess meshes enhanced
GiD_Result, new 'gauss_point' sub commmand to manage gauss point definitions and 
'result_ranges_table' to manage 'result ranges tables'.
GiD_Graph tcl function to handle postprocess graphs.
drawopengl: new suboption -getstring vendor|renderer|version|extensions
GiD_Geometry list surface unrendered, to know the surfaces with problems to create its 
render mesh.
GidPriv(HideQuadraticTypeLevel) global variable to be used by a problemtype to hide 
and disable not allowed quadratic options.

 BeforeRunCalculation event: retuning -cancel- and an optional value the calculation is 
not started.
 GiD_Info parametric line Tcl command, new subcommand length_to_t to obtain the line 
length.
 Package vtk added to scripts.
New GiD-Tcl events: AfterCreateGroup, BeforeDeleteGroup, AfterRenameGroup

 Tcl events BeforeMeshErrors and BeforeResultReadErrors
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 GiD_Info events : to know the list of raised events

2.1.1 From v 11.0-rc2 to 11.0-rc3

Preprocessing:

 Removed groups which were added in version 10.2.1 .
 Fixed bug when contactvolumes, semi-structuredvolumes and unstructured 
quadrilateral were in contact.
 Check if number of nodes generated is lower than the allowed by the license after 
generating mesh using MeshFromBoundary.
 Fixed bugs in semi-structured volumes
 Fixed bug in rjump: sometimes lines were 'artificially' marked not to be skipped.
 Fixed bug related with meshing or not entities in frozen layers.
ATI + labels: corrected problem were overlapping labels were not drawn overlapped, 
only latest was drawn, now they are drawn overlapped. Also the background of the 
labels are now transparent.
quadratic elements:  corrected draw problem in normal render mode where quadratic 
elements always were drawn with lines, despite the user preferences.
drawing meshes: in flat render, lines now are drawn black, always.
PS / EPS: corrected crash when saving the vectorial version of these formats.
 Rebuild by boundary: now original surface number is maintained, and a 'No try planar' 
option is added to avoid rebuilding the shape as trimmed planar, and force be 
untrimmed.

General:

Fullscreen: if the mouse is near the upper left corner, the view menu appears, this is the 
same menu as the right mouse button menu.
New version checking:  now GiD, at the beginnig checks if there is a new version and 
tells the user if so.
Clip planes window: now clip planes can be set nearer or further than the ones set by 
Zoom Frame.

PostProcess:

Border graph and line graph:  corrected problem were a graph could not be done for 
scalar results if its component name was different than the scalar result name itself.
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Dividing meshes: now the new meshes inherits the properties of the original meshes: 
colour, style, transparency, interior drawing mode, etc.) to avoid black drawing artifacts 
such as drawing interior elements of volume meshes by default, when the original mesh 
wasn't drawing them.
Legends: of contour fills, contour lines, graphs, isosurfaces, vectors now they adjust 
their width according to the contents and font type and size.
Vector legend: corrected problem when min == max.

2.1.2 From v 11.0-rc1 to 11.0-rc2

General:

 Macros icons can be selected from themed GiD icons, or import an image file that will 
be converted to the current toolbar button size.

Preprocessing:

 Fixed bug when selecting several surfaces for seting forced points in them (Mesh 
Criteria->Forced Points). Sometimes some point was not assigned to the corresponding 
surface.
 Fixed bug related with structured prism meshing when the volume has 'NoMesh' criteria 
assigned.
 Fixed bug related with meshing progress advance bar

Postprocessing:

Result surface + vbo:  corrected bug which caused that the result surface visualization 
was wrong with vertex array or vertex buffer objects, or crashed gid.
 Labels & legends & graphs: corrected background problems for labels and legends when 
background was choosen with two dark colours.
 Labels:  corrected bug which caused that some labels were overdrawn by other mesh 
layers.
hidden lines & hidden boundaries:  corrected colour for these styles when background 
was choosen with two dark colours.
 Transparencies:  corrected problem which caused the model to be drawn twice when 
parts of it, or the whole model, were drawn transparent.

Customization:
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 Tcl events BeforeMeshErrors and BeforeResultReadErrors
 GiD_Info events : to know the list of raised events
GiD_GetWorldCoord screen_x screen_y :
given the screen coordinates ( screen_x, screen_y) returns a list with sis coordinates: 

{ x y z nx ny nz}

being 

( x, y, z) the coordinates mapped into the world ( model) of the screen coordinates, 

( nx, ny, nz) the normal vector components of the world ( model) pointing to the 
user. 

the mapping screen --> world ( model) is done by intersecting the line perpendicular to 
the screen, passing through the coordinates ( screen_x, screen_y), with the plane 
parallel to the screen ( in real, model, world ) at the centre of the view / model. The 
returned normal is the normal of this plane.

2.1.3 From v 10.2.1d to 11.0-rc1

General:

Password is changed from 10.x to 11.x, then a new password will be required.
Ask the user for theme 'classic' or 'black' when starting the first time.
Snapshot: all image formats have been merged into a single "write image file dialog", 
where the user can choose the format by selecting the apropiate filter or entering the 
corresponding extension.
Views:  new Utilities -> Variables -> ReadViewWithModel variable to disable reading 
views when a project is read in pre or a model is read in post.

Preprocessing:

Meshing in parallel. The volumes can be meshed in parallel using the number of threads 
wanted by the user (set at Preferences->General).
Rball sphere/circle mesher updated.
Fixed bug in volume Octree mesher.
VA, VBO:  less memory required to get unique lines when drawing meshes in normal 
render mode. corrected problem with quadratic elements.
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Postprocessing:

Node traces:  now traces of nodes can be drawn. For a single mesh for the whole 
analysis, the node will follow the path of the deformed mesh across all steps. When 
several meshes are used for several time steps, then the nodes can follow the track of 
the original mesh or from the deformed one.
ATI cards:  corrected problem where the axes and model is drawn black after returning 
from postprocess mode to preprocess mode.

Customization:

New GiD-Tcl events: AfterCreateGroup, BeforeDeleteGroup, AfterRenameGroup

2.1.4 From v 10.2.0d to 10.2.1d

What's new from version 10.2.0d to 10.2.1d

Preprocessing

Group management:  conditions over groups of entities. New Groups data similar to 
organize geometric and mesh entities without the limitation of layers (an object can't 
belong to multiple layers)

2.1.5 From v 10.1.9d to 10.2.0d

What's new from version 10.1.9d to 10.2.0d

General:
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 Ttk themed windows (experimental 'Dark GiD theme' and 'Classic theme')

Preprocessing:

 New Delaunay volume mesher using Tetgen.
 Mesh from boundary: new option to fit or not the surface boundary, allowing refinement 
(now for Tetgen only)
 Improvement in the automatic detection of Master surface in semi-structured volumes.
 Improvement in final mesh quality in unstructured quadrilateral meshes.
 Improvements in semi-structured volume mesher.
 Labels + ATI cards: corrected bug displaying labels with the latest catalyst driver.

Postprocessing:

 New import of Vtk format mesh and results, implemented as an auxiliary plugin
Result surface  on Lines will draw them using the result as thickness, including 1gp 
results.
Merge:  corrected error when merging meshes with set number specified for each 
element.
Isosurfaces: corrected wrong style which was sometimes set when reading files.
Shadows + ATI cards + contour fill as texture: corrected bug which caused errors with 
this combination and which caused posterior visualization problems even when shadows 
where off.
Shadows + nVidia / Intel cards + contour fill as texture and transparencies:  corrected 
bug which caused visualization artifacts when the combination was used and c.fill had 
some transparent outer limits.
Contour Fill / Contour ranges: option to display the range just under the cursor.
Result surfaces: using this result visualization style on lines will draw lines with their 
thickness depending on the absolute value of the result. For nodal and 1 gauss point 
results.
Animation Window: make gif options more evident to the user, so that they can be 
selected more easily.
 corrected error when merging and exporting ascii files.
 corrected problem when displaying animated vectors with multiple meshes after no 
results was selected.
Edge colour: added new option to define the colour to be used to draw edges, instead of 
the default black colour ( Options --> Geometry --> Change edge colour...).
PDF output: now outputs images in pdf format. 
PLY export: shown meshes can also be exported in the Polygon File Format, aka. 
Stanford Triangle Format. Ascii and binary. Nodal results of current selected step are 
also written in the PLY file as nodal properties.
Statistical results: macro passed to Windows menu, which creates a statistical result: 
foreach node calculates the minimum, maximum, average or the standard deviation of 
all values, i.e. across all steps, of the selected result.

Customization:

 BeforeRunCalculation event: retuning -cancel- and an optional value the calculation is 
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not started.
 GiD_Info parametric line Tcl command, new subcommand length_to_t to obtain the line 
length.
 Package vtk added to scripts.

2.1.6 From v 10.1.8d to 10.1.9d

What's new from version 10.1.8d to 10.1.9d

Preprocessing:

 Modification of hierarchy of layers, now parent layers exists explicitly. The layer tree 
information is imported now from Rhino files.
 Selection of entities filtering subtypes: e.g. to assign a condition defined over volumes - 
over face elements only to surfacic elements
 Draw curvature of curves by colors.
 Fixed bug modifying field values of conditions applied to layers.
 Fixed bug related with some specific case of boundary layer meshing.
 Fixed bug related with the use of the meshing preference 'Avoid elements with all its 
nodes in boundray'. Sometimes GiD crashed if this variable was set.
 Fixed bug related with Forced Points in surface. Sometimes some points were not 
present in the final mesh.
 Fixed bug concerning automatic correct sizes for meshing. 
 Fixed bugs when reading the user preferences.
 Improvements in surface meshing when chordalerror is assigned in meshing 
preferences.
 Fixed bug related with semi-structrued volume meshing when closed entities were 
involved.

Customization:

GidPriv(HideQuadraticTypeLevel) global variable to be used by a problemtype to hide 
and disable not allowed quadratic options.

General:

 Va + quads from hexas: corrected bug which caused to drawn wrong the quadrilateral 
faces of hexahedrons using vertex arrays.
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 Spheres + internal texture: brighter texture when drawing spheres in this mode and in 
without light ( render normal).
 New ground plane: can be used as floor ( shadows are drawn on it) or as mirror.
 New mirror effect: the model is mirroed on a ground surface with the window View --> 
Other viewing effects..

.

 Create results and graphs: layout rearranged and tool tips added.
 Backup: a version will only recover a backup if it was written by its exact GiD version, 
not from other GiDs.
 Some widgets have been updated to Ttk style.
 Now GiD checks if there is a new version available.
 User colour map, for contour fills for instance, are named and saved between sessions.
 Stream lines: can be exported and imported ( in the same model), new command to 
delete all stream lines at once.
 Post Result State: now stream lines are saved between sessions.

2.1.7 From v 10.1.6d to 10.1.8d
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What's new from version 10.1.6d to 10.1.8d

Preprocessing:

 VA + VBO: now circles and spheres are drawn
 Fixed bug when ForcedPoints were used in surfaces, using triangle quadratic mesh.
 Sphere generator preferences: circumvented the problem that caused rball preferences 
not to be saved.
 Fixed bug in boundary layer mesher. Sometimes not all the layers were generated.

Customization:

GiD_MeshPost tcl function to create postprocess meshes enhanced
GiD_Result, new 'gauss_point' sub commmand to manage gauss point definitions and 
'result_ranges_table' to manage 'result ranges tables'.
GiD_Graph tcl function to handle postprocess graphs.
drawopengl: new suboption -getstring vendor|renderer|version|extensions
GiD_Geometry list surface unrendered, to know the surfaces with problems to create its 
render mesh.

General:

 Now the splash window shows the packages being loaded at start time. Can be 
switched off in ConfigureProgram.tcl

Postprocessing:

 Import plug-in: added support for complex scalar and complex vector results, now they 
can be imported too.
 Graphs: corrected some bugs related to undefined results and importing graphs with no 
titles.
 Spheres: support for VA and VBO for faster drawing of nice spheres.
 Display vectors: corrected bug which caused gid to crash after this sequence: open 
multiple files + c.fill of resA + animate + displayVectors of resB + (zoom in) + animate 
AND c.fill was done using textures AND display of monochrome vectors.
 Standard (internal) gauss points (GP_TRIANGLE_1, GP_QUADRILATERAL_4, ...) should 
not be explictly defined to be used.
 Delaunay: elements bigger than 10 times ( default) the mean size of elements are 
culled. Check Utilities --> Variables --> PostDelaunauCullBigElements to modify it.
 Macros: Added macro to create a result with the minimum, maximum or average value 
of a scalar for all steps.
 Create Results: added some single operator functions ( sqrt, log10, db10, db20, abs, 
exp, inverse (1/)) to Window-->Create Result...
 Graphs: new tcl command GiD_Graph
** GiD_Graph show --> shows the graphs
** GiD_Graph hide --> hides the graphs
** GiD_Graph list --> list the existant graphs
** GiD_Graph clear --> deletes all graphs
** GiD_Graph get <graph_name> --> gets the graph data of "graph_name", the same 
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as the create data.
** GiD_Graph delete <graph_name> --> deletes the graph "graph_name" causing an 
error if does not exists
** GiD_Graph create <graph_name> <label_x> <label_y> <list_x_values> 
<list_y_values> <unit_x> <unit_y> --> creates the graph "graph_name" with the 
provided information, causing an error if the graph already exists.

 Graphs: added discrete Fourier Transform of a Graphs. Uses the y values as real part 
and 0 as the imaginary part for the fft transformation. The graph created will use an 
index for the x axis and the real, imaginary or module of the dft result as the y axis. 
Check Options-->Graphs-->dFT-->real , imaginary or module

 Graphs: added discrete Fourier Transform of a Graphs. Uses the x values as real part, 
and the y values as imaginary part for the fft transformation. The graph created will use 
an index for the x axis and the real, imaginary or module of the dft result as the y axis. 
Also the graph created can have as x axis the real part and as y axis the imaginary part 
of the dft result. Check Options-->Graphs-->dFT complex-->real , imaginary, module or 
complex
 Read of postprocess files with GiD postprocess HDF5 format written by the GiDPost 
library, and postprocess files with Amelet HDF5 format.
 Create Results: added option for operators +, -, * and / which now accepts a scalar or 
vector ( both can be complex) as second operand check the window: Window-->Create 
Result...
 Create Results: added operators sqrt, log10, db10, db20, abs, exp, inverse (1/) which 
operates on one result. Only operators +, -, * or  /  accept scalars,vectors 
or results as second operand. SqrtAbs, Abs, Log10Abs, Exp, 1/ requires a result as 
second operator.
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 New Create Graphs window: to create graphs from another ones, with following 
operators: +, -, *, /, sqrt, log10, db10, db20, abs, exp, inverse (1/), derivate, integral 
and fit. The "g1 fit g2" operator fits the bounding box of the second graph g2 to the 
bounding box of the graph g1. Also interpolador has been added: CubicSpline and 
Catmull-Rom Spline. Graphs can also be scaled and traslated in order to match another 
one. This is the new window, and below some interpolated graphs examples.
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 Create Graphs: added dFT options:
 create graph( idx, dft.real) or dft( idx, dft.imaginary)
 sale y values according to the number of items
 get half the values, dft seems to be symmetric

 Graphs: corrected bug when doing line graphs on volumes
 Animation + several results: corrected bug when doing animation of several results 
combination isosurface + contour fill
 Result state: corrected bug which caused the results menu not to be displayed when an 
incorrect step was present in the result state file (.vv)
 Integration graph: added tangencial and un projected vector integration for lines and 
2d
 Graphs: now, if the Amelet plugin is present, they can be exported to the Amelet HDF5 
format
 Post preferences: circumvented the problem that overwrites the user preferences with 
original ones.
 Graphs: corrected bug in Options --> Graph --> Invert Graphs .
 Label results: now labels of vectors, tensors and local axes displays a letter with the 
component's name.
 Extract boundaries: corrected bug when creating boundaries from a quadratic element 
mesh
 VA + VBO: now quadratic elements are drawn as several triangles / cuadrilaterals, 
instead of drawing them as linear elements if Utilities --> Preferences --> Graphical --> 
DrawQuadraticElements is set to "As lines".

2.1.8 From v 10.1.5d to 10.1.6d

What's new from version 10.1.5d to 10.1.6d
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Preprocessing:

 Fixed bug in 3D Boundary Layer Mesh, in cases where the boundary layer ends in onto 
a surface.
 Boundary layer mesher is faster.
 Fixed bug in SurfMesh meshing, when Avoid Elements in Boundary option (from 
meshing preferences) was set.

Customization:

 New Tcl-GiD event AfterAssignMaterial { name leveltype }
 Fixed bug when transfering conditions over nodes, when they came from isolated 
points.
 hdf5 plugin updated to version 1.4
 verifp plugin updated to version 1.33
 GiD_MeshPost tcl command to create postprocess mesh
 Special self-updated field #FUNC#(NumPointToNumNode), to automatically convert the 
point number in a node number

Postprocessing:

 Stream lines: faster search tree creation ( up to x4) for the first stream line.
 Post state: solved bug which caused mesh styles to be read wrong.
 Toolbar's buttons: now icons can be showed with short names or names alone.
 Tooltips can be: showed as always, disabled or displayed at the bottom of the main 
window.
 Graphs: corrected bug when doing a graph with undefined results such a node evolution 
of a result which is not defined for that node.

2.1.9 From v 10.1.4d to 10.1.5d

What's new from version 10.1.4d to 10.1.5d

Preprocessing:

 Edit NURBS: conversion to Bezier form for curves and surfaces.
 Fixed bug in unstructured quadrilateral mesher.
 Fixed bug related to automatic correct sizes.
 Fixed bug to do remote calculations using procserver.
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Customization:

 GDAL as Tcl package to read/write GIS digital terrain models from multiple formats 
(Arc/Info, tiff and most image formats ,etc)
 GDAL plugin using the previous package to import GIS files as geometric or mesh 
entities

Postprocessing:

 Legends outside: corrected bug which caused that legends were not displayed in an 
independent window ( Options --> Legend --> Outside).
 Several meshes: corrected problem which slowed down the deformation of the meshes 
of the current step.
 Display vectors & other vector related results: corrected bug which caused gid to crash 
when the comments where displayed.
 Display vectors: first time fixed size vectors is used, the minimum size is 8.
 results cache + several meshes: free results always except in the last meshgroup.
 Linux + usb: better usb checking.
 Postscript vectorial mode: if model is 2D no triangle discretization is done and so, 
smaller files are created.
 GUI: added 'disable tooltips' preference
 Loading single file: corrected bug which caused what the display information was 
calculated twice
 Remote display ( Linux): disabled Vertex Array / Vertex Buffer Object in remote 
visualization which caused GiD to crash.
 Gauss points: solved problem while reading gauss points with given natural coordinates 
for prisms and pyramids.

2.1.10 From v 10.1.3d to 10.1.4d

What's new from version 10.1.3d to 10.1.4d

Preprocessing

Fixed bug in volume mesher
Fixed bug in lines orientations when reconstructing geometry from mesh.

Postprocessing

 Contour Lines: corrected bug which caused the contour lines to be drawn black in 
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render flat or smooth.
 Contour Lines + VA / VBO: now contour lines are drawn in Vertex Array or Vertex 
Buffer Object mode.

2.1.11 From v 10.1.2d to 10.1.3d

What's new from version 10.1.2d to 10.1.3d

Preprocessing

Option for manual creation of nodes and elements.
ACIS import updated until version 20.
Fixed bug in rjump mesher. Now its probability of succes in meshing surface patches 
skipping inner lines is higher.
Improvements in quadrilateral unstructured mesher.
Fixed bug creating copy of triangles by offset.
Enhanced bottleneck when splitting elements with applied conditions
Fixed bug in mesh collapse, and less memory is required.
Fixed orientation bug when copying volumes by mirror.
 Visualization: VA + VBO mode, the selected elements and surfaces are now drawn 
correctly.
 Visualization: VA + VBO mode, now the colour of the mesh can be coloured by layer or 
with a single colour ( dark green) through the preferences window.
 Mesh generation: now the final message tells the user if the generated mesh is 
quadratic or not.
Improvements in RSurf and RJump surface mesher.
Improvements and bugs fixing in IsoStuffing unstructured volume mesher.
Fixed bug concerning quadrilateral unstructured mesher.
Fixed bug concerning quadratic unstructured meshes.
 Visualization: Inmediate mode, now the colour of the mesh can be coloured by layer or 
with a single colour through the preferences window.

Customization

 Conditions: added #WIDTH# option in the value description to specify the length, in 
characters, of the entry used by the user to enter the value of the condition (already in 
GiD 10.1.0d but not acknowledged). For instance: 

CONDITION: Volume_Vector_function
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CONDTYPE: over volumes

CONDMESHTYPE: over nodes

HELP: Here you can define a function/expresion ...

QUESTION: Ux

VALUE: 0.0#WIDTH#(64)

END CONDITION

 Tcl events for materials: AfterCreateMaterial, AfterRenameMaterial, 
BeforeDeleteMaterial, AfterChangeMaterial.

Postprocessing

 Health check: added option to filter outlier vertices, for instance, to filter out vertices 
with coordinates bigger than 1e+32.
 Mesh read: for line elements, accept 'line' keyword ad element type in the mesh 
description line, besides the old keyword 'linear'.
 OffScreen: added ofscreen support for MS Windows and Linux, so that GiD can work in 
background ( or batch queue), for instance to create long animations or a series of 
snapshots.
 OffScreen: added button in the Animation Window to create a batch file to be used with 
GiD in background or batch mode.
 Graphs: fixed a couple of bugs regarding label displays and repeated names.
 Animation Window: rewind button puts slider at the user selected starting step, and not 
the first step of the analysis.
 Result state: corrected bug when restoring the line diagram visualization at start-up.
 Result state: corrected bug when restoring the result surface visualization at start-up, 
and its options.
 New results types:

 ComplexScalar: results with two components: real and imaginary part --> a + b · i
 ComplexVector: vectors with six components: ( rX + iX, rY + iY, rZ + iZ). If not 
provided, GiD will calculate the modulus of the real part ( sqrt( rX^2 + rY^2 + 
rZ^2), of the imaginary part ( sqrt( iX^2 + iY^2 + iZ^2) and of the whole vector ( 
sqrt( rX^2 + rY^2 + rZ^2 + iX^2 + iY^2 + iZ^2)
 DisplayVectors visualization draws both parts ( real and imaginary) when the 
modulus of the whole vector is selected
 LineDiagram draws both parts ( real and imaginary) when the modulus of the whole 
vector is selected.
 Stream lines can be done on the real part ( field) of the complex vector or on the 
imaginary part ( field).
 Look at the customization and reference manuals to get more information on how to 
specify complex numbers for GiD.

 Animation: GiD now can save animations in a new format: Macromedia Flash Video 
(.flv)
 Contour fill and transparencies: corrected problem when using contour fill with textures 
and switching layers to transparent. Also when creating png's.
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 Result cache: corrected problem regarding several meshes in different timesteps
 Graphs: corrected problem with integral graphs and cuts.
 Labels: limited the maximum amount of labels to be displayed to 5.000.
 Translations: corrected problems when passing the result's name to the translation 
routine into another language.
 Icons: added an icon in the 'Standard bar' showing GiD's mode: preprocess or 
postprocess.
 Corrected bug when extracting boundaries and exporting ASCII boundaries from 
hexahedral meshes. 
 STL export: added option to select whether the quadrilaterals should be divided into 
two or four triangles
 Graphs: new Point Complex Evolution graph, similar to 'Point Evolution' but for complex 
results, where both real and imaginary part of the result are displayed as 'x' and 'y' in 
the graph.
 Icon bars: the contour options icons and the graphs icons have been grouped into two 
submenus, so the general view is less cluttered
 Stream Lines: creation options are more visible now: View results --> Stream lines --> 
Single point / Along line / In a quad(rilateral)
 Stream Lines: made the algorithm a bit faster for big meshes made and for the first 
stream line.
 Images / animations: for contour fills or results surfaces with contour fill colours, 
corrected transparency issue.
 Show Min Max: added 'show minimum', 'show maximum' and ' show min max' options 
which shows the minimum result alone, the maximum result alone or both at once.
 Multi-monitor support: corrected problem which caused windows no to be reopened in 
the second monitor.
 Translations: corrected problem regarding result names with spaces in legend and 
comment boxes.

General

 Linux + ATI drivers: workaround to the problem which caused GiD to lock just after 
saving project or image with 'selection lines by software ( emulation front buffer)' on.
Problemtypes Abaqus, Ls-Dyna and Nastran updated to use floating PasServer licences

2.1.12 From v 10.1.1d to 10.1.2d

What's new from version 10.1.1d to 10.1.2d
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Preprocessing

 Join volumes for geometric edition
 Edge Collapsing in triangles mesh. If the normals of selected elements are not 
coherent, now GiD make them coherent in order to be able to detect the sharp edges of 
the mesh.
 Quadratic type of the model (variable IsQuadratic) loaded automatically when the 
model is loaded.
 Added option to draw higherentity on mesh edges. (View->Higher Entities->Edges)
 Default element type in semi-structured volumes is tetrahedra (before, it was prism).
 Improvements in render mesh.
 Bugs fixed related with meshing compatibilities checking before meshing 
semi-structured volumes.
 Bugs fixed related with 3D boundary layer meshing.
 Improvements in Isosurface volume mesher.
 Cartesian mesher: added SizeRatio option and removed WeightStart/End
 Cartesian mesher: support to read cartesian 'face' and 'edge' elements (Amelet format)
 Bugs fixed related with semi-structured volume meshing.
 Structured lines: if ndivisions is zero (default), now the number of cells equivalent to 
the unstructured size is assigned. In previous versions 2 divisions were applied.
Improvements in unstructured size transition regarding volume unstructured mesher.
Improvements in the smoothing with HighGeom option (trying to minimize the chordal 
error in surface meshes).
Background image is saved and restored with the GiD model, and new menu option to 
show or hide it.
Correct sizes operations before meshing are faster because of improvements.

Customization

 New -elementtype and -higherentity options in GiD_Info layer command 
GiD_Info layer -entities elements -elementtype $type $layername1 $layername2 ...

GiD_Info layer -entities nodes -higherentity $num $layername1 $layername2 ...

 BeforeDeleteLayer event: if it returns -cancel- the layer deletion is cancelled.
 GiD_Geometry get/create now allow also contactsurface and contactvolume
 New Tcl command GiD_BackgroundImage get|set show|filename|location <values>

Postprocess & General

 More, and bigger, bitmap fonts for PGF's PmFont style.
 Colours: changed first default color in pre (Layer0) and postprocess, corrected 
automatic color change/reset.
 Contour Fill: bugs corrected related to gauss points, using same minimum and 
maximum limits
 Plugins: New import plugins ( mesh and results): PLY format, OFF format, added a tcl 
progress bar in ply plug-in
 Plugins: Automatic load of plugins under Files --> Import --> Plugins, of the dynamic 
libraries located in $GID/plugins/Import/.../NamePlugIn/NamePlugIn.dll ( or .so)
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 VA / VBO: improvements and bugs corrected in VBO / VA visualization mode, in pre and 
in postprocess mode.
 Results cache: when reading a big file, lasts steps remain in memory ( so many as 
memory pool specified by the user).
 Graphs: problems corrected related to title, point style visualization ( disconected node 
graph), repeated names.
 Selection in post improved.
 Linux / Mac: verify that the defaults files are owned by the owner of the directory 
where they are ( corrected problem when GiD is launched as root from a user home 
directory).
 Added option ( checkbox) to WarnWin window to 'skip these messages'.
 Corrected bug when selection analysis and steps.
 Plugins: added new function: GiD_GetTclInterpreter so the GiD's tcl interpreter can be 
used inside the client plug-in, PLY + progressbar example added.
 New PostProgressBar: using the 'tile' progress bar in postprocess, allows indeterminate 
progress too.
 Warning if contour fill uses textures and the user tries to generate a vectorial ( 
encapsulated) postcript file.
 Spheres & circles: corrected bug when drawing them transparent in c.fill.
 Page Setup window with information about the dimension of the image to be generated 
( in mm/inches and pixels).
 Post Import plug-ins now also works in Apple's Mac OS X. Makefiles provided too.
 Read state: corrected problem while reading result surface parameters
 Result surface: now works with VA / VBO and, when drawing elevations, now takes into 
account diferent normals on boundaries
 Result surface: support for gauss points results and VA / VBO.
 Line graph: added option to use the x, y or z coordinates as 'x' axis, besides the already 
existant 'line variation' option.
 Create result window can mix results between different analysis and time steps
 Results cache & Merge: corrected bug using Results cache
 Results cache & Merge: check if some files uses mesh 'Group's and some no, issue an 
error if so.
 Render: Added two new fixed lights ( switchable separately): one orange and another 
blue, accesible throught the right mouse button menu.

2.1.13 From v 10.1.0d to 10.1.1d
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What's new from version 10.1.0d to 10.1.1d

Preprocessing

 Bugs corrected related with meshing compatibilities checking before meshing 
semi-structured volumes.
 New option: DontDrawNormals/DrawNormals in Utilities --> SwapNormals to avoid 
draw the normals when there are a lot of surfaces, or when the process is automatized, 
for instance, in a macro.
 Bugs corrected related with 3D boundary layer meshing.
 Quadratic type of the model (variable IsQuadratic) loaded automatically when the 
model is loaded.
 Support for Vertex Arrays and Vertex Buffer Objects so that the drawing of lots of 
surfaces (in flat or smooth render mode) and meshes (in any render mode) is faster.
 Preferences --> OpenGL & Postprocess: added option to draw the preprocess mesh with 
smoothed normals at the vertex or not.
 Initial green color for Layer0 has been changed to dark red.

Postprocessing

 New option: Options --> Geometry --> Extract boundaries from shown volume and 
surface meshes; for each mesh creates a set with its boundary elements. The original 
mesh is left untouched.
 New option: Options --> Geometry --> Separate connected components from shown 
volume and surface meshes; for each mesh detects groups of connected elements and 
stores them in separate sets. For instance a single volume mesh which corresponds to 
three unconnected spheres will be separated into three sets each one containing the 
volume elements of a single sphere. The original mesh is left untouched. By default a 
maximum of 50 connected groups will be separated into separated sets. This limit can 
be modified with the variable Utilities --> Variables --> PostMaxNumComponents on the 
main's window the right menu.
 Display Window can be integrated into GiD's main window
 PGF Fonts: now True Type fonts are also used in Mac OS X, thanks to free type library 
actualization
 Vertex Arrays / Vertex Buffer Objects bug correction caused no display or crahes gid 
some times when colors are not correctly defined in the range 0.0 ... 1.0. Also some 
memory leak is corrected.
 Read State: when the state is read and all meshes were off, now all are siwtched on.
 Tk OpenGL: correction of the error which, when the colour was changed using 
PGFFonts, the second printed string used the specified colour.
 Results cache: now works in MS Windows

2.2 Detailed changes of 10.0.x official releases

2.2.1 From v 10.0.8 to 10.0.9
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What's new from version 10.0.8 to 10.0.9

(10.0.9 version is not available yet)

General

External window: avoid errors using mouse-wheel
Avoided problems when resizing the main window to very small size

Preprocess

Fixed bug concerning automatic correct sizes for meshing. 
Natran import: fixed bug importing CE2 entities, and avoid crash with problemtype 
Nastran loaded.
IGES import: removed bottleneck of very slow reading with some patologic case (like 
DPW4_wbt_ih+0_v03.igs of GiD tutorial)
Rhino import: fixed some crash

Customization

LoadGIDProject envent invoked with full path also is a model is readed with relative 
path, to avoid problems to problemtypes
Tcl procedure WaitUntilAllProcessTerminate to force that GiD doesn't exit until all 
calculation processes have finished (usefult for batchs and tester)

Postprocess

Fixed bug restoring automatic comments

2.2.2 From v 10.0.7 to 10.0.8
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What's new from version 10.0.7 to 10.0.8

Preprocess

Fixed bug concerning automatic correct sizes for meshing. In some cases the size 
already assigned to the entity was not taken into account, and only the general mesh 
size was used. 
Fixed bug when ForcedPoints were used in surfaces, using triangle quadratic mesh.
Fixed bug related with some specific case of boundary layer meshing.
Fixed bug related with the use of the meshing preference 'Avoid elements with all its 
nodes in boundray'. Sometimes GiD crashed if this variable was set.

Postprocess

 Graphs: corrected bug when doing a graph with undefined results such a node evolution 
of a result which is not defined for that node.
 Graphs: corrected some bugs related to undefined results and importing graphs with no 
titles.
 Display vectors: corrected bug which caused gid to crash after this sequence: open 
multiple files + c.fill of resA + animate + displayVectors of resB + (zoom in) + animate 
AND c.fill was done using textures AND display of monochrome vectors.

2.2.3 From v 10.0.6 to 10.0.7

What's new from version 10.0.6 to 10.0.7

Apple's Mac OS X version uploaded.

Preprocessing

 Fixed bug in unstructured quadrilateral mesher.
 Fixed bug in 3D Boundary Layer Mesh, in cases where the boundary layer ends in onto 
a surface.
 Fixed bug in SurfMesh meshing, when Avoid Elements in Boundary option (from 
meshing preferences) was set.

Customization

 Fixed bug when transfering conditions over nodes, when they came from isolated 
points.
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Postprocess

 Legends outside: corrected bug which caused that legends were not displayed in an 
independent window ( Options --> Legend --> Outside).
 Several meshes: corrected problem which slowed down the deformation of the meshes 
of the current step.
 Display vectors & other vector related results: corrected bug which caused gid to crash 
when the comments where displayed.
 Display vectors & other vector related results: corrected bug which caused gid to crash 
when the comments where displayed.
 Display vectors: first time fixed size vectors is used, the minimum size is 8.
 Linux + usb: better usb checking.
 Postscript vectorial mode: if model is 2D no triangle discretization is done and so, 
smaller files are created.

2.2.4 From v 10.0.5 to 10.0.6

What's new from version 10.0.5 to 10.0.6

Preprocessing

 Fixed bug in unstructured quadrilateral mesher.

Postprocessing

 Contour fill and transparencies: corrected problem when using contour fill with textures 
and switching layers to transparent. Also when creating png's.
 Graphs: corrected problem with integral graphs and cuts.
 Labels: limited the maximum amount of labels to be displayed to 5.000.
 Multi-monitor support: corrected problem which caused windows no to be reopened in 
the second monitor.
 Translations: corrected problem regarding result names with spaces in legend and 
comment boxes.

2.2.5 From v 10.0.4 to 10.0.5
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What's new from version 10.0.4 to 10.0.5

Pre Process:

Fixed bug in rjump mesher. Now its probability of succes in meshing surface patches 
skipping inner lines is higher.
Improvements in quadrilateral unstructured mesher.
Fixed bug concerning quadrilateral unstructured mesher.
Fixed bug of intersections
Fixed bug in 3D boudary layer mesher
Fixed bug in Isostuff mesher
Improved efficiency when splitting elements with applied conditions
Fixed bug in node collapse
Try to Detect USB device for latest Ubuntu distributions

Post Process:

* Linux / Mac: verify that the defaults files are owned by the owner of the directory where 
they are ( corrected problem when GiD is launched as root from a user home directory).

 Corrected bug when selection analysis and steps.
 Graphs: problems corrected related to title, point style visualization ( disconected node 
graph), repeated names.
 Warning if contour fill uses textures and the user tries to generate a vectorial ( 
encapsulated) postcript file.
 Spheres & circles: corrected bug when drawing them transparent in c.fill.
 Plugins: added new function: GiD_GetTclInterpreter so the GiD's tcl interpreter can be 
used inside the client plug-in.
 Post Import plug-ins now also works in Apple's Mac OS X. Makefiles provided too.
 Read state: corrected problem while reading result surface parameters

2.2.6 From v 10.0.3 to 10.0.4
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What's new from version 10.0.3 to 10.0.4

Preprocessing

 Bugs fixed related with meshing compatibilities checking before meshing 
semi-structured volumes.
 Bugs fixed related with 3D boundary layer meshing.
 Quadratic type of the model (variable IsQuadratic) loaded automatically when the 
model is loaded.
 Bugs fixed related with semi-structured volume meshing.
 batch files always needs .bch extension

Postprocessing:

 selection: faster when selecting lots of elements or nodes, corrected a bug when 
selectiong nodes
 linux: corrected explosion when shadows where on and creating a hires image with 
nvidia drivers
 avoid som redraw's
 c.fill with textures: corrections when min = max, and when only 1 colour was selected
 c.fill: corrected error when drawing interior elements of volume meshes and in pg's
 graphs: corrected 'dot' style, title box adjusted when itle is changed
 Linux: owner of .gidDefaults and .GiDPostPreferences.ini is the same as owner of 
directory where these files are, usualy $HOME
 mesh colours: corrected bug which reseted the colours after deforming, animating or 
cutting meshes.
 utilities status: store volume and area values, avoiding recalculating them innecesarily
 Post state: on quit, save only if there is a model loaded.
 post state: if saved state is graph view, then stay in normal postprocess view.
 results cache: several corrections
 fonts: corrected bug when fixed width font is selected( pmfont).
 tkogl: when using opengl from Tk, corrected problem when setting the color of printed 
fonts (PGF).

2.2.7 From v 10.0.1 to 10.0.3



78From v 10.0.1 to 10.0.3

What's new from version 10.0.1 to 10.0.3

General

 Minor bugs corrected

Preprocessing

 Fixed bug when checking prismatic topology of volumes, to allow to assign 
semi-structured meshing properties to the volume. 
 Improvements in advancing front volume mesher (tetrahedra).
 Fixed some bug in 3d boundary layer mesh generation.
 Fixed bug deleting materials

Postprocessing

 Postprocess state saves and reads isosurfaces information.
 Stream line bug corrected.
 Graphs: Point evolution and integral graphs bugs corrected. Now works also for 1 Gauss 
Point per element.
 Graphs: Integral works also for 1 Gauss Point per element.
 Graphs: Fixed bug changing 'y' scale
 Postprocess state saves and reads stereo and shadow information.

2.2.8 From v 10 to 10.1.0d

What's new from version 10 to 10.1.0d

Preprocessing
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 Fixed bug creating a volume with holes.
 Join surfaces: transfer conditions to the joined entities
 ACIS import: try to read files with version higher than 7.00 
 Fixed bug copying an arc by scaling with different xyx scale
 Fixed bug specifying coordinates related con local axes: 'local_axes_name' x,y,z

Meshing

 Cartesian mesh with non-uniform grid spacing and settings in preferences window
 Fixed bug when checking prismatic topology of volumes, to allow to assign 
semi-structured meshing properties to the volume. 
 Improvements in advancing front volume mesher (tetrahedra).
 Fixed some bug in 3d boundary layer mesh generation.
 In 3D boundary layer mesh generation, improved the way of deciding when to stop 
shifting a node, depending on the proximity of the close nodes in the isotropic mesh.
 Fixed bugs with sphere/circle meshing with conditions over face elements

Postprocessing

 Use of Open GL's Vertex Arrays and Vertex Buffer Objects. Utilities --> Variables --> 
OGL_useMeshObjects values:

 OGL_useMeshObjects = 0 --> draw using immediate mode
 slow, no extra memory, 
 safe & quick graphic mode, works always

 OGL_useMeshObjects = 1 --> draw using Display Lists 
 quick, uses memory to create objects, 
 safe & quick graphic mode, works always, 
 limited number of elements

 OGL_useMeshObjects = 2 --> draw using Vertex Arrays
 quick, uses less memory than Display Lists, 
 safe & quick graphic mode, works always, 
 better suited for Software mode and Intel graphics cards

 OGL_useMeshObjects = 3 --> draw using Vertex Buffer Objects
 quick, uses less memory than Display Lists but more than Vertex Arrays, 
 safe & quick graphic mode, OpenGL 1.5 required, 
 better using a graphic card

 Postprocess state: now saves and reads isosurfaces information.
 Stream lines: bug currected which causes to get short lines on very slow velocities.
 Stream lines: faster location of elements when a stream line is created.
 Graphs: Point evolution and integral graphs bugs corrected.
 Postprocess state: now saves and reads stereo and shadow information.
 Integral: New option in Integral calculation: '2D' mode, in order to do vector integration 
over lines in 2D (normal of line = vector( Node0, Node1) ^ Vector( 0, 0, 1))
 Preferences: new panel for Postprocess options:

 Draw method: immediate mode, display lists, vertex arrays or vertex buffer objects
 Enable or disable use of textures to draw Contour Fills
 Enable or disable 'Results cache': ( Linux, Mac OS X) uses a portion of the main 
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memory as 'cache' of results so that not all the results are loaded into GiD. The 
amount of main memory to be used can also be specified. 

 Graphs: Point evolution and integral graphs bugs corrected. Now works also for 1 Gauss 
Point per element.
 Graphs: Integral works also for 1 Gauss Point per element.
 Graphs: new option to show the values of a graph into a table window.

Customization

 $GID/plugins folder, recursivelly load all tcl files with the same name as the folder. 
 GiD_Info group_entities
 GiD_Cartesian get|set ngridpoints|boxsize|corner|dimension|coordinates|iscartesian 
<values>
 Cartesian() GiD variables MinSizeMainGrid WeightStart WeightEnd GridUniform
 BeforeMeshGeneration GiD-Tcl event now stop the generation when returning -cancel-
 Tcl global variable ::GidPriv(PostSpaceDimension) to declare that our resuls is 2D (e.g. 
to integrate results in 2D projection)
 package hdf5 updated from 1.0 to 1.2 (-vtype string|char allow creation of sets of 
strings, and unsigned chars)
 package tablelist updated from 4.9.1 to 5.1
 Fixed bug on Linux with conditions with 'grid fields'

2.2.9 From v 10 to 10.0.1

What's new from version 10 to 10.0.1

General

 Minor bugs corrected

Preprocessing

 Minor bugs corrected 

Postprocessing

 Postprocess state saves and reads isosurfaces information.
 Stream line bug currected.
 Graphs: Point evolution and integral graphs bugs corrected.
 Postprocess state saves and reads stereo and shadow information.
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What's new from version 9 to 10 

GENERAL FEATURES

Mac OS X version
Added stereoscopy (3D view) support with anaglyphs and Quad planes and save 
animations.
Added shadow support using the shadow mapping technique for a better depth 
perception and enhance presentations.
GMED: new module for treatment of medical images.
Added shadow support. 
Ready for Windows Vista an 7
Added support for usb's SpaceNavigator and 3D SpaceBall in Linux
Plugins: tcl files inside the \plugins folder will be automatically sourced when starting.
zoom centered on the current cursor when using mouse wheel

PREPROCESSING

Rhinoceros 4.0 export
Import of x y z? ASCII files as points of nodes
Import of 'ply' mesh files
Geometric surfaces reconstruction from triangle or quadrilateral meshes.
Join surfaces (also able to rebuild a single surface by contour)
Boolean operations with multiple selection
Tcl wrapper of the HDF5 library to read/write this data format.

MESHING

Boundary layer mesh generation in 3D
Generation of quad dominant meshes (surface mesh with quadrilateral and triangles), if 
a meshing preference is set. 
New unstructured volume mesher available, based on constrained Delaunay algorithm.
New unstructured non constrained volume mesher, based in Isostuffing.
Force Points to Volume Mesh option available (Mesh Criteria->Force Points to Volume 
Mesh)
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 Sphere/Circle mesher options in preferences window and new generation algorithms.

POSTPROCESSING

Graphs: polar graphs, logarithmic scales, draw axes and labels, select grid color.
Integral of a scalar or vector result over a mesh part.
New Points/Circles/Spheres visualization mode: Internal texture
Support for 'Units' has been added, both for mesh and results:
Options-->Geometry-->Create delaunay meshes  allows the user to create delaunay 
meshes from the nodes of the postprocess model
New 18 nodes prism element
New file *.post.lst: a file which contains a list of the files for multiple meshes and 
graphs.
Isosurface exportation is done now with GiD format.
Visualization: in the 'View Style' windows, posibility to visualize the preprocess model 
(geometry or mesh) with the postprocessed results. There is also de posibility to selec 
which render mode to use with the preprocess model.
Basic postprocess state is saved and restored.

CUSTOMIZATION

CompassLIB problemtype Toolkit
Separated customization manual
New Tcl events:

AfterChangeBackground 
AfterRenumber
BeforeCopy, AfterCopy, BeforeMove, AfterMove
AfterCreatePoint, BeforeDeletePoint, AfterCreateLine, BeforeDeleteLine, etc.
AfterCreateLayer AfterRenameLayer BeforeDeleteLayer AfterChangeLayer 
AfterSetLayerToUse
AfterCreateDimension BeforeDeleteDimension
AfterChangeLicenceStatus

Tcl-GiD commands:
GiD_Geometry can get and create more types of surfaces: plsurface, coonsurface and 
meshsurface
GiD_Geometry create line: new option to create NURBS interpolating points
GiD_Mesh'get' to obtain information of nodes and elements
GiD_Info Mesh also for meshes of post
GiD_Result create , -array option to efficiently handle data
GiD_Info IsPointInside
 New Tcl commands to register procedures (interesting for plugins)

 To modify menus: GiD_RegisterPluginAddedMenuProc, 
GiD_UnRegisterPluginAddedMenuProc
 To handle dropped files with some extension: GiD_RegisterExtensionProc, 
GiD_UnRegisterExtensionProc

GiD_OpenGL get modelviewmatrix|projectionmatrix|viewport  , and 
polygonoffsetfill constant
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GiD_OpenGL pgffont pushfont | popfont | print | dimensions | foreground | 
background
.central.s graphmode , dynamicbox, and dynamicline
objarray command to ask type and length of this vector object

 New bas template commands:

 *loop conditions nodes|bodyelements|faceelements|layers
 *condname, *condnumfields, *condelemface *condhaslocalaxes
 *matprop, *cond, *gendata, *intvdata: without arguments print all fields

Other:
Grid data showed with a new widget to easily copy/paste big data, and a XY plot can 
be drawn
Added option #WIDTH# to the Value: field in .cnd to set a specific width for value 
entries in the Condition Window
Data Conditions NewCond process command, to define a new condition at runtime
Hide/show all volume related menus and toolbars when setting the global variable 
GidPriv(HideVolumeLevel) to 1/0
Updated to Tcl/Tk 8.5.8
Added more Tcl packages: Tktable, sqlite, ..., and the rest updated to the latest 

3.1 From v 9.3.1b to 10.0

What's new from version 9.3.1b to 10.0.RC1

General:

First 10.x release candidate version, with new password required.
added options to draw, or not, the background images when taking pictures or saving 
animations
File browser support links

Preprocess:

Delaunay volume mesher also for quadratic meshes.
Improvements in unstructured quadrilateral mesher.

Customization:

Added option #WIDTH#(width_of_entry) to the Value: field in .cnd to set a specific 
width for value entries in the Condition Window
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3.2 From v 9.3.0b to 9.3.1b

What's new from version 9.3.0b to 9.3.1b

General:

Tcl/Tk scripting interpreter updated from 8.5.6 to 8.5.8 version.
More USB memory sticks allowed to register GiD

Preprocess:

Parasolid format import updated from version 16004 to 20000
Meshing: isolated points generate isolated nodes, and these nodes are visualized (by 
default nodes are hidden)

Postprocess:

variable PostDoStereoAnimation
Polar graphs enhanced

Customization:

GiD_OpenGL get modelviewmatrix|projectionmatrix|viewport , and polygonoffsetfill 
constant
GiD_OpenGL pgffont pushfont | popfont | print | dimensions | foreground | background
.central.s graphmode , dynamicbox, and dynamicline
objarray command to ask type and length of this vector object

Fixed bugs:

Circle/sphere mesher bug with conditions over face elements
Copy of elements by mirror with conditions over face elements
Copy by offset, don't allow create 'contact volumes'
Tcl error unselecting materials
Crash on GiD x64 for Windows selecting from menu a batch file to be read and other 
menus.
Error in Windows Vista and 7 running the external 'only points' volume mesher.
HDF5 Amelet import corrections
Shadows fixed bugs
Fixed some bug in Semi-structured volumes with structured prisms
problems running batch files without any window (-n flag)
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postprocess mirror inverted the orientation of the elements

3.3 From v 9.2.9b to 9.3.0b

What's new from version 9.2.9b to 9.3.0b

General:

Improvements in meshing advance bar..
Shadows can also be used in preprocess.

Preprocess:

Improvement in unstructured quadrilateral mesher: better element quality when very 
sharp sizes transition are present.
Included option to reconstruct one surface by contour.

Postprocess:

corrections
 Stereo and Shadow options are melted into the same window.
Basic postprocess state is saved and restored, the state variables saved are:

 mesh information: on/off, display style, color, transparency, edge width, vector 
filter factor
 result information: current result visualization, except stream lines

Customization:

GiD-Tcl event proc AfterChangeLicenceStatus { status }
GiD_Result create , -array option to efficiently handle data

3.4 From v 9.2.8b to 9.2.9b

What's new from version 9.2.8b to 9.2.9b
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General:

Draw selected lines with a higher width in render mode.

Preprocess:

Improvement in volume mesher based in advancing front
Improved surface structured meshes
Better treatment of meshing parameters to be used when meshing.
Fixed bug when meshing boundary layer mesh, and more than boundary layer affected 
the same volume.
Fixed some bugs in volume mesher based in isostuff method
Fixed bug when assigning Cartesian mesh to entities.
Fixed bug when meshing semi-structured volumes

Postprocess:

 Added shadow support. GiD uses the shadow mapping technique. By clicking 
View-->Advanced options... following window will appear:
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Stereo and shadow options.

 Use shadow: enables or disables the shadows visualization.
shadow color: this option controls if the shadows should be black or shoule be drawn 
with and dimmable ambient light.

shadow bias: this advanced options allows the user to adjust the offset between the 
oclusor and the shadow. The default value is -0.002.

finer silhoutte: this advanced option allows the user to control the granularity 
of the shadow, i.e., the resolution of the texture to be used to create the 
shadow. By default, i.e. deactivated, the same graphical window is used to 
created the shadow texture. An accelerated OpenGL 2.0, or the framebuffer 
object  extension is needed for this option to be used. If checked, the options 
are 

medium:  which uses a texture of 1024 x 1024 pixels to create the 
shadow map, using 4 MB of memory,
high:  which uses a texture of 2048 x 2048 pixels to create the 
shadow map, using 16 MB of memory,

very high: which uses a texture of 4096 x 4096 pixels to create the shadow 
map, using 64 MB of memory,
highest: which uses a texture of 8192 x 8192 pixels to create the shadow 
map, using 256 MB of memory.

NOTE: requires OpenGL 1.5 upwards
NOTE: for the 'finer silhouette',  OpenGL 2.0 or the framebuffer object  extension is 
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required.

Customization:

Grid data showed with a new widget to easily copy/paste big data, and a XY plot can be 
drawn

3.5 From v 9.2.7b to 9.2.8b

What's new from version 9.2.7b to 9.2.8b

General:

 fixed save stereoscopic animations using quad buffers

Preprocess:

Improvements in volume mesher based in advancing front method.
Improvements in volume mesher based in Isostuffing.
Improvements in geometry boolean operations (new 'Substract and intersect' operation)

Postprocess:

 Changed Contour Fill drawing algorithm. Now uses textures achieving a Speed-Up 
between 2x and 20x. Can be activated and deactivated with the right button menu 
option: Utilities-->Variables-->OGL_useCFillTexture and entering 1 or 0 respectivelly, in 
the command line.

Customization:

 Ramdebugger package updated from version 7.1.2 to 7.7.1
 fulltktree package updated from version 1.7 to 1.8

3.6 From v 9.2.6b to 9.2.7b

What's new from version 9.2.6b to 9.2.7b
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General:

 Fixed some important bug of the 9.2.6b version
 Save stereoscopic animations

3.7 From v 9.2.5b to 9.2.6b

What's new from version 9.2.5b to 9.2.6b

General:

-openglconfig option also works in Linux.
 Added stereoscopy ( 3D view) support with anaglyphs and Quad planes ( if there is 
hardware support). Also specific Contour fill colours scales has been added for anaglyphs 
stereo mode. By clicking on View-->Stereo... or on Utilities-->Tools-->Stereo... 
following window appears:
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Stereoscopy window possibiliting 3D view

  which allows the user to set following options:

stereo mode: selects the stereo mode to use between anaglyph colors and quad 
buffers
eye distance:  distance between left and right eyes, which influences the stereo 
perception
eye distance mode: the eye distance can be specified in absolute mode, i.e. the 
distance is always the same (in meters) regardeless the dimension of the currently 
visualized model, or scaled with the model.
left/right color mask: set the colour buffer ( red, green, blue or alpha) to filter for 
the anaglyphs.
dynamic update: if on, any change on the window will be shown inmediately in the 
model visualization window.

Animation: if the selected stereo mode is quad buffers,  then the left and right eye 
frames are stored together in a double width frame in the animation file. Only avi files 
are supported.

Preprocess:

 Improvements (robustness and efficiency) in unstructured volume mesher based in 
Advancing Front technique.
 Improvements in unstructured surface mesher RFAST (based in AdvancingFront 
technique).
 Added the possibility to get the meshing parameters from the ones saved with the 
model (user can see them from Utilities->Status) or from the meshing preferences 
(Utilities->Preferences). The choice is made just before the mesh generation, when the 
general meshing size is asked.
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New mesh generation window

Automatic verification of constrained boundary for the Delaunay tetrahedra mesher
Improvement in the list mass properties, independent of the current surface render 
quality
GiD variable DrawBorderElementVol to disable drawing a border of volume elements (to 
speed up redraw)

Customization:

Hide/show all volume related menus and toolbars when setting the global variable 
GidPriv(HideVolumeLevel) to 1/0

Postprocess:

 Integration graph: integral of a vector result or scalar component over a mesh through 
all the steps of an analysis. The results can be a nodal result or a smoothed gauss point 
result.
 Visualization: in the 'View Style' windows, posibility to visualize the preprocess model 
(geometry or mesh) with the postprocessed results. There is also de posibility to selec 
which render mode to use with the preprocess model.

3.8 From v 9.2.4b to 9.2.5b

What's new from version 9.2.4b to 9.2.5b

General:

 plugins: tcl files inside the \plugins folder will be automatically sourced when starting.

Preprocess:
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 New unstructured volume mesher available, based on constrained Delaunay algorithm.
 Surface reconstruction from triangle or quadrilateral meshes.
 Quadratic option inside meshing preferences, instead of in the Mesh menu.
 Automatic correct sizes: the sizes correction does not affect to entities which are not 
topologically in touch, althought they are close in space.
 Improvements made when using a background mesh for unstructured size assignment

Customization:

 New GiD-Tcl events: 
AfterCreateLayer AfterRenameLayer BeforeDeleteLayer AfterChangeLayer 
AfterSetLayerToUse
AfterCreateDimension BeforeDeleteDimension

 New Tcl Info commands:
GiD_Info IsPointInside

 New Tcl GiD commands
 GiD_Geometry create line, option to create NURBS interpolating points

 New Tcl commands to register procedures (interesting for plugins)
 To modify menus: GiD_RegisterPluginAddedMenuProc, 
GiD_UnRegisterPluginAddedMenuProc
 To handle dropped files with some extension: GiD_RegisterExtensionProc, 
GiD_UnRegisterExtensionProc

 New bas template commands:
 *loop conditions nodes|bodyelements|faceelements|layers
 *condname, *condnumfields, *condelemface *condhaslocalaxes
 *matprop, *cond, *gendata, *intvdata: without arguments print all fields 

Postprocess:

 File *.post.lst: can also contain a list of graphs (*.grf ).
 New graph: integral of a result over a mesh through all the steps of an analysis. The 
results can be a nodal result or a smoothed gauss point result.

3.9 From v 9.2.3b to 9.2.4b

What's new from version 9.2.3b to 9.2.4b

General:

 Calculate: the priority and the affinity of the selected running calculation can be 
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adjusted on MS Windows and Linux. On MAC OS X only the priority can be changed.
 Page Setup --> Page and capture settings: added options to select whether to capture 
images or record movies with a white background instead of the displayed one.
 The problem type's name appears in the title of the main window, together with the 
project's name.
 command line: if gid is started with a name of a postprocess file, then it changes to 
postprocess and loads the file. This can happen when a user drags and drops a 
postprocess file over the GiD icon on the desktop.

Pre:

 Sphere/Circle mesher options in preferences window.
 Import of unstructured meshes with Amelet HDF5 format
 Improvements in surface mesher to make easier volume meshing.

Post:

 Gauss Points: elemental results (1 gp per element) are transfered to cuts/sets, so that 
these type of results can be drawn on cuts/sets.
 View Style: a list of predefined colours of materials has been added in the view style 
window.
 New file *.post.lst: a file which contains a list of the files to be read by the postprocess:

 The first line should contain one of these words: Single / Merge / Multiple to read a 
single file, merge the list of files or handle them as several meshes (for diferent time 
steps);
 rest of lines: the files to be read, with one filename per line;
 both comments starting with '#' and blank lines are admited;
 if the filenames do not have its absolute path, then the path of the file containg the 
list will be used;
 the file will be read if it's inside a gid project ( 
projectName.gid/projectName.post.lst);
 and can also be read with File-->Open (select the proper filter).

 The file *.grf (which contains graphs) is read when:
 changing from pre to post process and projectName.gid/projectName.post.grf exists, 
or
 the postprocess files are read through File-->Open, then example.msh/res/bin and 
example.grf are read.

 Delaunay: added option to force a triangulation of 3D points, the axis with less delta is 
skipped. Repeated points are also skipped and the user gets a message.

Corrections:

General:

Pre:

 Corrected some minor bug in 3d boundary layer meshing.



94From v 9.2.3b to 9.2.4b

 Enhanced boolean operations and intersections.

Post:

 Spheres/Circles: Corrected bug when these elements are selected. Now they are also 
drawn in red when selected.
 Vectors/Matrices/LocalAxes: corrected bug which causes to display vectors although the 
mesh is switched off.
 Fonts: corrected error which prevents the user to change the fonts for legends, 
commands, etc.
 IsoSurfaces: with several isosurfaces at once, corrected problems when the step is 
changed.
 ShMinMax: labels now are always drawn
 Contour Fill: corrected problem that does not change the display style when hidden 
lines and render were used together.
 Multiple meshes: when a mesh is deleted, then all the meshes with the same name in 
each time step are also deleted.
 Delaunay: added repeated points detection and warning.
 XYZ ascii files ( *.txt) are not added to the recent post files.
 isosurface exportation is done now with GiD format.

3.10 From v 9.2.2b to 9.2.3b

What's new from version 9.2.2b to 9.2.3b

General:

 corrected option to load problemType from the command line: gid -p problemType
 Initial OpenGL Configuration takes into account the previous user preferences and 
default preferences
 Initial OpenGL Configuration: when Software mode is selected, it also activates the 
emulateFronBuffer (dynamic lines by software)

3.11 From v 9.2.1b to 9.2.2b

What's new from version 9.2.1b to 9.2.2b
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Preprocess:

 New version of the circles and spheres mesher (rball)

Postprocess:

 Support for 'Units' has been added, both for mesh and results:
 Mesh: add Unit "Unit name" between MESH and Coordinates keywords
 Result: add Unit "Unit name" between Result and Values keywords
 ResultGroup: for each result in the group, add Unit "Unit name"  below its 
ResultDescription line
 on the icon bar a status label show the unit used by the mesh, for instance Units: m
 clicking on this status label, the user can change the units used to draw the results: 

Window to the change results units

3.12 From v 9.2.0b to 9.2.1b

What's new from version 9.2.0b to 9.2.1b
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General:

 MAC OS X: OpenGL acceleration enabled. Software OpenGL can also be selected from 
GiD preferences window.
 New window for first time use to select between accelerated OpenGL (faster) and 
software OpenGL (safer).
 Fixed bugs using batch files

Preprocess:

 Improvements in recognizing prismatic shapes for semi-structured volume meshes.
 Fixed bugs in structured surface meshing and semi-structured volumes.
 Fixed bugs in closed surfaces meshing (like cylinders).
 Boolean operations with multiple selection
 Division of polylines.
 Fixed render surfaces bug on Linux x64

Customization:

 New GiD-Tcl events: 
 AfterRenumber
 BeforeCopy, AfterCopy, BeforeMove, AfterMove
 AfterCreatePoint, BeforeDeletePoint, AfterCreateLine, BeforeDeleteLine, etc.

Postprocess:

Utilities-->Status shows also accumulated length, areas and volumes of the elements of 
the model.
 Isolines are also converted to cuts, when the option Options-->Iso surfaces-->Convert 
to cuts is selected.
Options-->Geometry-->Create delaunay meshes  allows the user to create delaunay 
meshes from the nodes of the postprocess model in three ways:

One for each visible mesh: creates separate delaunay meshes, one for each displayed 
mesh/set/cut
Single mesh for all visible meshes: creates a single delaunay mesh from the nodes of 
the displayed meshes/sets
Single mesh for all points: creates a single delaunay mesh from all the loaded points 
in postproces, belonging or not to an existing mesh/set.

After the delaunay mesh(es) creation GiD applies an alpha shape algorithm to delete 
detect contours the the mesh, if possible.

Files-->Merge joins meshes with the same element type and same name.
View results icon bar: dynamic slide bar to scale the deformation when the 
deformation's icon is selected.
 Enchancements and fixed bugs:

 better visualization of circles in 'internal texture mode'
 correct position of legends, comments and axis boxes in high resolution hardcopies

 New element: prism with 18 nodes: the 6 vertices, the 9 in the middle of the edges and 
3 in the centre of the four sided faces.
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3.13 From v 9.1.1b to 9.2.0b

What's new from version 9.1.0b to 9.2.0b

Preprocess:

 Force Points to Volume Mesh option available (Mesh Criteria->Force Points to Volume 
Mesh)
 Possibility of assigning real size (not num of divisions) for structured mesh
 Improvements in structured mesh
 Fixed some bug related to closed surfaces meshing
 Improvements in chordalerror mesh size limiting using meshing preferences
 Laplacian smoothing of line elements
 Option to load meshing preferences from model in Mesh menu
 Generation of quad dominant meshes (surface mesh with quadrilateral and triangles), if 
a meshing preference is set. 
 Import of 'ply' mesh files
 Improvements in intersections and boolean operations

Postprocess:

 Import of ASCII files, compresed with (g)zip or not, which contains only the coordinates 
x, y [ z] of points. Coment character and format of the line can be adjuste in the open 
import file dialog box. For example: with the format '%*d %g %g %g" the x, y and z 
coordinates can be read from a file with indexed coordinates like in this line: '1 2.345 
7.543 3.876'.
 StatusLabels has been added in the iconbar reflecting the number of nodes and 
elements, render and transparency modes. Clicking over them triggers an action: 
Utilities-->Status for 'number of nodes/elements', cycling over the render and 
transparency modes for the 'render and transparency status labels'.
 In the 'File-->Merge' dialog box, several files can be selected to be merged together. 
Useful to read mesh+result pieces of a partitioned model.
 Several Graphs can be read from the same file, they only need to be separated by the 
line 

# Graph: "(unique) Title of the graph"

   which corresponds with the format of the graph files described in the manual

 All graphs are written in a unique file when the option File-->Export-->Graphs-->All is 
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selected.
 Translation of the graphically supported TTF fonts for vectorial PostScript and 
Encapsulated Postcript output.
 Linux: after a couple of seconds the full path is poped up when the mouse is over a file 
in the Recent Files menu.
 Added icon for OpenMultiple files in the icon bar.

 several corrections regarding graphs, emulateFrontBuffer, Dimensions and PS vectorial, 
and othres...

Generic:

 First GiD 9.x version for Mac OS X
 Added support for usb's SpaceNavigator and 3D SpaceBall in Linux, with left button for 
ZoomFrame and right button for ResetView (XY plane).
 Now the OGL_emulateFrontBuffer preference is also saved.

3.14 From v 9.1.0b to 9.1.1b

What's new from version 9.1.0b to 9.1.1b 

Preprocess:

Import of x y z? ASCII files as points of nodes
Export template DXFSAP2000 updated
Two more variables to control the chordal error of the whole model when generating the 
mesh

Postprocess:

 STL ascii and binary export of triangular and quadrilateral meshes. Only the displayed 
ones are exported
 New Points/Circles/Spheres visualization mode: Internal texture. This option is a 
compromise between a nice view and a quick response time.
 Display of axes, Matlab like, for the visualized model
 Option to attach the progress bar, when a file is opened or written, in the main 
windows, avoiding unnecessary redraws
 Visualization of scaled results, including the logarithm of the result: log( factor * 
ResultValue + Offset)
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 Logarithmic graphs
 New option to improve the quality of the saved GIF images: Dither666 and Dither595, 
in the "Save GIF file box"
 The new meshes created with transformations have the same colour as the originals

Generic:

zoom centered on the current cursor when using mouse wheel
GIF: used dithering to convert the 24bit-colours to gif 256 colours' pallete.

News for problemtype developers:

Updated to Tcl/Tk 8.5.6
GiD_Info project subcommands RequireMeshSize and RecommendedMeshSize
GiD_Geometry can get and create more types of surfaces: plsurface, coonsurface and 
meshsurface

3.15 From v 9.0.x to 9.1.0b

What's new from version 9.0.x to 9.1.0b 

Preprocess:

Boundary layer mesh generation in 3D
Rhinoceros 4.0 export
Creation of a NURBS surface from triangle elements 
Improvements in quadrilateral mesher
Time savings in mesh compatibilities checking (before begining the mesh generation), 
and reading mesh files.
Boolean operations: 'NoDeleteVolumes' and 'NoDeleteSurfaces' subcommand to 
maintain the source entities
Cartesian mesh: 

support of boundary conditions
use castesian-like numeration of mesh entities,
read only GiD variables to know the cartesian divisions, etc . Can be asked with the 
Tcl command GiD_Set

   Cartesian(NGridPoints) : return the number of points of the grid on each direction x, 
y, z

Cartesian(BoxSize) : dimensions of the box of the cartesian mesh bounding the 



100From v 9.0.x to 9.1.0b

model

Cartesian(Corner) : location of the left-down corner of the cartesian box

Cartesian(FromRenderMesh) variable, to set if the cartesian mesh is obtained fastly 
from the render mesh
Cartesian(CondFaceElem) variable, to set where to transfer conditions over face 
elements: to body elements or face elements

Layers window enhanced: fully redisegned window, with tree of layers, integrated 
layout, etc.
Selection 

New filter:NumSides=xx , where xx is the number of sides of the entity (sufaces or 
volumes)
'ParentsOf' command, to select the parents of some entity

Postprocess:

 Scale result in contour fill (scale factor or logarithmic).
 Graphs: logarithmic scales, draw axes and labels, select grid color.
 Animation: several options to control the duration of the animation, including the use of 
the step values.
 Draw arrows option in stream lines.
 GiD variable OGL_useMeshObjects, to activate/deactivate OpenGL draw lists.
 Time savings doing cuts.

Generic:

 Internal changes for future Mac OSX version (soon available), and offscreen rendering
 Fixed some Windows Vista platform problems:

 Lock when showing big meshes
 Sysinfo bugs
 Graphical problems with Aero Glass and Intel graphic cards: use emulation of front 
buffer.

 Software OpenGL option in the graphical preferences window, to enable/disable the 
hardware acceleration

News for problemtype developers:

Updated to Tcl/Tk 8.5.5
New Tcl event AfterChangeBackground when changing color or other properties
Tcl command GiD_Mesh 'get' subcommand, to ask for mesh information
Tcl command GiD_Info Mesh also for meshes of post and -array efficient option
GiD_Info Postprocess get with -array option
GiD_Info Postprocess axis_option
GiD_Info List_Entities Dimensions
New Tcl_Obj types to handle efficiently vectors of int, float or double (interesting for 
C/C++ developers of plugins)
conditions 'over face element single', the face with the same normal as the source 
surface will be marked.
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Data Conditions NewCond process command, to define a new condition at runtime (e.g. 
when importing shapefiles, to create new conditions to handle attached information)
dev_kit.tcl: Predefined procedures to customize TKWIDGET data fields
TKWIDGET: GidUtils::TkwidgetGetFilenameButton , to add a 'pick filename' button

TKWIDGET: GidUtils::TkwidgetPickNode , to add a 'pick node' button

TKWIDGET: GidUtils::TkwidgetGetLayername, to add a 'layer' combo box

GidUtils::Disable/Enable writebatch to de/activate the writting of the batch file
ConfigureProgram.tcl: variableGidPriv(MenuType) with values 'native' or 'generic' to use 
native or generic menus

3.16 from v 9.0-rc1 to 9.0-rc2

What's new from version 9.0-rc1 to 9.0-rc2 

The name of the main stresses components (Si, Sii and Siii) of the matrix results can be 
specified
Isolines created for surface meshes when the isosurface option is selected.
Option added to switch isolines off: (rightbuttons) 
Results-->IsoSurfaces-->DisplayStyle-->Showisolines
Inverted Black and White colour scale.
New Tcl command: GiD_Thumbnail get [ width height] to get a downscaled image of the 
current view.
Preview image in the 'Page Setup' window.
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What's new from version 8.0.x to 9.0.x 

PREPROCESSING

 Visualize layer labels 

 Rhino import updated to version 4 
 DXF import: support of 3DSOLID entity (ACIS based)
 Improvements in parasolid import
 CGNS mesh format import 
 Draw surface curvature : mean, gaussian, main directions. Get them with GiD_Info
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 NURBS simplification operators: knot removal and degree reduction for curves and 
surfaces

 Volume split (similar to surface split, to divide a volume from a group of dividing 
surfaces)
 Surface render using triangle strips
 Join surfaces function.
 Sphere element new mesh quality filters: NumNeighbors and SpaceFilling
 Transparent layers
 Combobox in the toolbar to select the current layer to use
 Mesh/nomesh criteria can be applied also to points
 Draw meshing data related to boundary layer and Points forced to the mesh
 Advance bar when reading GiD projects
 JoinSurfaces JoinCoplanary, new function to join coplanary neighbor surfaces
 GiD mesh ASCII reading: separe material in new layers

MESHING

 Meshing volumes with sphere elements and 2D surfaces with circle elements. 
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 Align nodes of structured and semi-structured meshes (variable 
AlignSemiStructuredNodes) 

 Apply background mesh sizes also when meshing lines 
 NetCDF format import (only mesh) 
 New mapping algorithm when meshing using Rsurf mesher 
 Creation of voxels from an VTK file (structured points dataset), GiD_VTK2OrthoHexa Tcl 
command

 Creation of hexaedra from an VTK file (structured points dataset), GiD_VTK2Hexa Tcl 
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command 
 Creation of isosurface of triangles from an VTK file (structured points dataset), 
GiD_VTKSP2MarchingCubes Tcl command
 Option to avoid elements with all its nodes in the boundary 
 Advance bar improvements: show number of generated entities 

 Global option to force a maximum relative chordal error of the mesh in 
Preferences->Meshing 

 New Rjump window to make easier the entities selection 
 Different interpolation scenario (2d or 3d) in surface structured meshing depending on 
the surface mesher selected (RFast or RSurf). 
 New quarilateral mesher
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 Boundary regular transition meshing preference

 Smoothing of triangles and quadrilaterals: new opcion LaplaceSmooth to only apply a 
laplacian smooth, with angle tolerance and try to save the enclosed volume
 Delaunay volume mesher (GiD_Set VolumeMesher 1)
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 Split tetraedra option
 Cartesian mesher

 RenumberMethod = 2 to renumber nodes following the XYZ axes
 Boundary layer meshing in 2D
 Swap normals in groups of line elements to orientate them coherently. 

POSTPROCESSING

 Smooth isosurfaces with results visualization and animation:

Free isosurface with smooth render
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Vorticity isosurfaces with contour fill of velocity

 Isolines created for surface meshes when the isosurface option is selected.
 Options added: Isosurfaces can be seen although all the meshes are switched off, and 
isolines can be switched off.
 Stream lines implemented for hexahedra, prisms, pyramids and quadrilaterals

 Options added for stream lines: length, initial step, maximum number of points 
 Stream ribbons as stream lines with detail level=2, with rotational, and the detail level 
'points' shows the calculated points from the stream:
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Stream line options

Stream ribbons of the velocity field with contour fill of pressure

 Supported hexahedra of 20 nodes in postprocess
 Macro to create a vector result from an scalar result
 Support for spheres (defined by a centre node and a radius) and circles (defined by a 
centre node, a radius and a normal) in Postprocess. Spheres can be cut and create in 
circles. If the normal for the circles are not given GiD assumes the normal ( 0.0, 0.0, 
1.0):

 Contour Fill colours with shininess
 New Display Style mode for meshes: 'Points Bound' showing the nodes as spheres and 
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the boundary lines of the mesh.
 Separate Styles can be selected for diferent meshes:

Setting different style for each mesh

 The width of edges of the elements can be set for each mesh.
 Inverted Black and White colour scale.
 The name of the main stresses components (Si, Sii and Siii) of the matrix results can be 
specified
 Option added to switch isolines off: (right buttons menu) Results  --> 
IsoSurfaces --> DisplayStyle --> Showisolines
 Postprocess variable PostCutToMesh, to automatically convert 'cuts' to 'sets'
 Option added to the animation window: the range of steps to do the animation can be 
defines, skiping the firsts and/or lasts steps
 Line graphs can be done with any projectable surface and in any position.
Option added: The displayed amount of vectors can be limited when there are lots of 
vectors to be drawn, for instance, when very dense meshes are used. The option allows 
to drawn only one vector of every N vectors. This 'N' can be customized by the user in 
the right buttons menu, under Results --> Options --> VectorFilterFactor. 

GENERAL FEATURES

 Memory savings to manage big meshes in pre and postprocess 
 Basic support of pyramid elements in pre and full support in postprocess
 Draw the support grid with labels and in postprocess too 
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 Use a two colors degradation as background

 Preview image saved with the model, to be show in the Open project window

 Views with the same name as the posprocess file, with the extension .vv, are 
automatically read
 Render environment projection to reflect predefined or user defined patterns in pre and 
postprocess 
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 Options for reflection: individual faces selection, layer color or two color degradation for 
switched off faces

 Can read TIFF files for background images and textures
 Locate real size background images from a .tfw georeferentiation file if exists
 A preview image and the view is saved together with the mesh and results
 The Preview image of the current visualization is shown in the 'Page Setup' window.
 Menu to load recent postprocess files
 Menu to select useful or last read and saved views.
 Spaceball device enabled for Windows-x64
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 User preference to set the number of 'recent files' to show in menus
 Updated to Tcl/Tk 8.5
 Support for Asian encodings in OpenGL
 Handling of True Type fonts in OpenGL, with smooth edges.
 Command line parameter -c2 <yourfile.ini>, to specify in a problemtype to use 
"yourfile.ini" instead "gid.ini", to avoid sharing the configuration
 New command line -t option to evaluate tcl code
 File browser window dialog can have additional parameters depending on the context 
(e.g VTK or IGES import preferences)
 Support for BMP files with 32bpp.
 The animation also saves the composed views in the 'Multiple windows' configuration, 
except the independent one.

CUSTOMIZATION

 Math functiones like max, min, log, log10 can be used in template bas files, *nintervals 
command
 Mathematical operator % (remainder of integer division) for template files
 bas template command *ElemsNormal, to get the normal for triangles, quadrilaterals 
and circles.
 GidUtils::DisableToolbar <tool> and GidUtils::EnableToolbar <tool>, to prevent show 
some tools, like the "Right buttons"
 drawopengl font GiD-Tcl command, to set fonts and ask its properties
 write_calc_data GiD-Tcl command, to write the calculation file from Tcl
 GiD_Info Tcl floating values with precision based on tcl_precision variable
 GiD_Info parametric curve t_fromrelativelength: Tcl procedure to calculate the 
parameter that provide the required arc length.
 New Tcl command: GiD_Thumbnail get [ width height] to get a downscaled image of 
the current view.
 GiD_UnAssignData : wherefield <fieldname> <fieldvalue> To unassign this condition 
olny for the entities where the field named 'fieldname' has the value 'fieldvalue'
 Several Tcl events:

 TclCalcModelBoundaries: Tcl event to calculate and set its own bounding box (for 
zoom frame)
 AfterSaveImage: Tcl event, interesting for example to save a georeference file (see 
dev_kit.tcl)
 BeforeTransformProblemType: Tcl event, to be raised just before this transformation

4.1 from v 8.0.x to 8.1.1b

What's new from version 8.0.x to 8.1.1b 
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Visualize layer labels 

Smooth isosurfaces with results visualization and animation 
Meshing volumes and 2D surfaces with sphere elements. 

Align nodes of structured and semi-structured meshes (variable 
AlignSemiStructuredNodes) 
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Memory savings to manage big meshes in pre and postprocess 
Rhino import updated to version 4 
CGNS mesh format import 
Basic support of pyramid elements 
Swap group to orientate coherently groups of line elements 
Apply background mesh sizes also when meshing lines 
Draw surface curvature : mean, gaussian, main directions. Get them with GiD_Info

NetCDF format import (only mesh) 
Creation of voxels from an VTK file (structured points dataset), GiD_VTK2OrthoHexa Tcl 
command
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Creation of hexaedra from an VTK file (structured points dataset), GiD_VTK2Hexa Tcl 
command 
Creation of isosurface of triangles from an VTK file (structured points dataset), 
GiD_VTKSP2MarchingCubes Tcl command
New mapping algorithm when meshing using Rsurf mesher 
Option to avoid elements with all its nodes in the boundary 
Advance bar improvements: show number of generated entities 

Global option to force a maximum relative chordal error of the mesh in 
Preferences->Meshing 
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Improvements in quadrilateral mesher 
Support to use arbitrary fonts in OpenGL (Asian encodings, etc) 
Render environment projection to reflect predefined or user defined patterns 

Draw the support grid with labels and in postprocess too 
Use a two colors degradation as background
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Options added for stream lines: length, initial step, maximum number of points 
New Rjump window to make easier the entities selection 
Different interpolation scenario (2d or 3d) in surface structured meshing depending on 
the surface mesher selected (RFast or RSurf). 
Views with the same name as the posprocess file, with the extension .vv, are 
automatically read

4.2 from v 8.1.1b to 8.1.2b

What's new from version 8.1.1b to 8.1.2b 

New quadrilateral mesher
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Boundary regular transition meshing preference

NURBS simplification operators: knot removal and degree reduction for curves and 
surfaces
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Preview image saved with the model, to be show in the Open project window

Can read TIFF files for background images and textures
Stream lines implemented for hexahedra, prisms, pyramids and quadrilaterals

Supported hexahedra of 20 nodes in postprocess
Macro to create a vector result from an scalar result
Smoothing of triangles and quadrilaterals: new opcion LaplaceSmooth to only apply a 
laplacian smooth, with angle tolerance and try to save the enclosed volume
Math functiones like max, min, log, log10 can be used in template bas files, *nintervals 
command
Delaunay volume mesher (GiD_Set VolumeMesher 1)
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Command line parameter -c2 <yourfile.ini>, to specify in a problemtype to use 
"yourfile.ini" instead "gid.ini", to avoid sharing the configuration
GidUtils::DisableToolbar <tool> and GidUtils::EnableToolbar <tool>, to prevent show 
some tools, like the "Right buttons"

4.3 from v 8.1.2b to 8.1.3b

What's new from version 8.1.2b to 8.1.3b 

Volume split (similar to surface split, to divide a volume from a group of dividing 
surfaces)
Locate real size background images from a .tfw georeferentiation file if exists
drawopengl font GiD-Tcl command, to set fonts and ask its properties
write_calc_data GiD-Tcl command, to write the calculation file from Tcl
New options for reflection: individual faces selection, layer color or two color 
degradation for switched off faces.
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 a preview image and the view is saved together with the mesh and results

4.4 from v 8.1.3b to 8.1.4b

What's new from version 8.1.3b to 8.1.4b 

 Support for spheres (defined by a centre node and a radius) and circles (defined by a 
centre node, a radius and a normal) in Postprocess. Spheres can be cut and create in 
circles. If the normal for the circles are not given GiD assumes the normal ( 0.0, 0.0, 
1.0).
 Stream ribbons as stream lines with detail level=2 with rotational.
 Detail level point for stream lines showing the calculated points from the stream.
 Contour Fill colours with shininess
 New Display Style mode for meshes: 'Points Bound' showing the nodes as spheres and 
the boundary lines of the mesh.
 Isosurfaces can be seen although all the meshes are switched off.
 Support for BMP files with 32bpp.
 Join surfaces function.
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4.5 from v 8.1.4b to 8.1.5b

What's new from version 8.1.4b to 8.1.5b 

Surface render using triangle strips
Mathematical operator % (remainder of integer division) for template files

4.6 from v 8.1.5b to 8.1.6b

What's new from version 8.1.5b to 8.1.6b 

Split tetrahedra
Cartesian mesher

Sphere element new mesh quality filters: NumNeighbors and SpaceFilling
GiD_Info Tcl floating values with precision based on tcl_precision variable
GiD mesh ASCII reading: separe material in new layers
DXF import: support of 3DSOLID entity (ACIS based)
Advance bar when reading geometry and mesh GiD files
Several improvements: quadrilateral unstructured mesher, Parasolid import, etc.
User preference to set the number of 'recent files' to show in menus
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Postprocess variable PostCutToMesh, to automatically convert 'cuts' to 'sets'

4.7 from v 8.1.6b to 8.1.7b

What's new from version 8.1.6b to 8.1.7b 

Boundary layer meshing in 2D
Transparent layers
Circle element (defined by a center, radius and normal to the plane), and internal 
sphere mesher.
Updated to Tcl/Tk 8.5
Spaceball device enabled for Windows-x64
GiD_UnAssignData : wherefield <fieldname> <fieldvalue> To unassign this condition 
olny for the entities where the field named 'fieldname' has the value 'fieldvalue'
Several Tcl events:

TclCalcModelBoundaries: Tcl event to calculate and set its own bounding box (for 
zoom frame)
AfterSaveImage: Tcl event, interesting for example to save a georeference file (see 
dev_kit.tcl)
BeforeTransformProblemType: Tcl event, to be raised just before this transformation
BeforeInitGIDPostProcess: Tcl even, raised just before change to postprocess mode

GiD_Info parametric curve t_fromrelativelength: Tcl procedure to calculate the 
parameter that provide the required arc length.
bas template command *ElemsNormal, to get the normal for triangles, quadrilaterals 
and circles.
Combobox in the toolbar to select the current layer to use
Mesh/nomesh criteria can be applied also to points
File browser window dialog can have additional parameters depending on the context 
(e.g VTK or IGES import preferences)
Menu to load recent postprocess files
Menu to set useful or saved views.

4.8 from v 8.1.7b to 8.2.0b

What's new from version 8.1.7b to 8.2.0b 
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JoinSurfaces JoinCoplanary, new function to join coplanary neighbor surfaces
Draw meshing data related to boundary layer and Points forced to the mesh
Use of PGF Fonts

4.9 from v 8.2.0b to 9.0-rc1

What's new from version 8.2.0b to 9.0-rc1 

New command line -t option to evaluate tcl code
RenumberMethod = 2 to renumber nodes following the XYZ axes



5 From v 7 to 8

127

What's new from version 7.0.x to 8.0.x 

NEW FEATURES - PREPROCESS

Implemented Microsoft Video1 codec with dithering, to save animations in AVI format 
Centered structured triangles 

Fill with tetrahedra a triangle boundary mesh (delaunay algorithm) 
Connect a cloud of points with tetrahedra (delaunay algorithm) 
Several macros added to the toolbar 
GiD-Tcl command: writedefaults to save to file the internal defaults 
GiD-Tcl command: GiD_GetInfoLnkFile to read .lnk Windows shell links 
3D Studio .3ds import 
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LoadFileInGidUnknowExtension event, to handle drag and drop from a problemtype 
Draw more mesh criteria 
Mesh criteria option to force the node of a point on the surface mesh 
Mesh criteria option to duplicate nodes for some selected entities to create a 
discontinuity 
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Automatic rotation center preference, and dynamic zoom centered on the first picked 
coordinate 
For menus can be specified the character used to acces with <Alt> key with an 
ampersand 
Previous and next view buttons 
Notes editor 

Conditions over face element multiple 
utf-8 encoding support for all GiD files 
Structured triangles for three-sided surfaces 
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Unassign conditions matching some field value 
Supported Windows shell links pointing to problemtypes 
Uncollapse volumes 
Intersect multiple surfaces, option to not divide surfaces and lines 
Tablelist widget updated to 4.1 
Automatic correct sizes: hard option based on chordal error 
Bas file, can set a variable with the result of a tcl procedure 
GiD_Info check command, to test possible bad entities 
Rhino 3.0 Import. New CAD import format 
New installation program 
RamDebugger provided inside GiD (F12 to open), sharing all needed packages 



131From v 7 to 8

SymmetrycalStructuredTriangles in preferences window 
Enhanced appearance of some windows (animation control, animation post, read batch, 
preferences, copy) 
Mesh errors enhanced: can reopen this window, better messages 
Unload problemtype 
Enhanced menus: (more logical location/name, disable/enable color by context, added 
icons) 
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New style to draw volume elements without need to see the mesh boundary 

Save and restore the project view 
Option to reload the last model when restarting 
Updated mesh menus for semi-structured meshes 
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Selection filter by condition fields 
New GiD-Tcl commands: GiD_SetModelName, AfterTransformProblemType event 
Structured volume meshes with contour surfaces with more than four contour lines. 
Hexahedrals smoothing. 
Mesh of structured prisms. 
More Edge collapse enhancements (pattern for special cases, smooting). 
Triangles split with linear or smooth interpolation, TolAngle parameter 

VRML import 
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Problemtype xml file to declare some properties: to show a customized icon in the open 
file dialog box, to call a function to know if the entered password is valid for the 
problemtype, etc. 
Structured hexahedras: corrected some degenerated cases, and enhanced interpolation 
of quadratic nodes. 
Mesh of structured tetrahedras. 
Transfer of applied conditions when splitting elements 
Rjump enhancements: mesh of quadrilaterals, draw by colors of entities to be jumped, 
show advance bar, some new variables for better control: RJump(TakeCareCurvature), 
RJump(TakeCareLayers), RJump(TangencyLimitAngle) 
Check of negative of zero jacobian on elements 
Semi-structured meshes
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Split of prisms and hexahedras to tetrahedras 
Source code updated for 64 bits support. 
Update to Tcl/Tk 8.4.9, and reordered and added some packages: tdom, img, treectrl 
Creation of approximated parametric surfaces 
Variable SymmetricalStructuredTriangles to create four triangles by quadrilateral instead 
two. 
Mesh quality: support for line and prism elements, new Minimum Jacobian criteria. 
Several translation modifications: optionbar widget changed to Bwidget NoteBook, etc., 
language dependent widgets size 
Function (meshing connectpoints) to create triangle elements (or surfaces) from a cloud 
of nodes, projecting in the plane z=0 
Transformation (copy / move) much faster 
Direct assignation to mesh of conditions with local axes 
Creation of NURBS lines fitting a list of points instead interpolating, with user selected 
degree. 
Events: BeforeRunCalculation, AfterRunCalculation, AfterOpenFile , ChangedLanguage 
GiD_Info Geometry 
GiD_GetInfoGeoFile, tr read the geo file version and problemtype 
Added OpenGL selection commands: rendermode, selectbuffer, getselection 
Sweep: must specify a end scale factor 
Selection: now it's possible to select element faces (to apply conditions) 
Selection of elements by tangency: ConnectedTangent and selected tolerance TolAngle 
(degrees) 
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Selection window: filters MinEdge and MaxEdge 
Selection, add syntax end-'num', for example: end , end-5:end 

Customizable macros toolbar 
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New RJump surface-group mesher, and manually options to jump or not a line.

Added a simple UNV mesh export template (Universal I-Deas format) 
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New status window button, to set the current meshing preferences with the saved in the 
loaded model file. 
More tolerant with spaces in layer names, materials, etc. 
Spanish translation of the stings database 
Enhanced VDA read (more stable, and less memory requirements) 
Enhanced IGES read (much faster, and less memory requirements) 
Try to save the applied conditions when modify entities, create a new copy, etc. 
Grid and snap: a tool to aid to the point definition by hand. 

Delete entities: new 'LowerEntities' option to delete all dependencies. 
Enhanced IGES export (optionally B-rep or traditional without topology style, more fast, 
saved layer information, etc) 
Selection: more entity filters: by label on/off, material or assigned condition. New 
InvertSelection command. 
Tcl/Tk: Included packages treectrl (a fast tree control) and tdom (a XML parser), and 
several scripts reordered as packages. 
Add to dev_kit.tcl more procedures: GidUtils::EvalAndEnterInBatch (to register tcl used 
command for undo and batch) 
GiD_BookBehaviour, GiD_MaterialBehaviour and GiD_ConditionBehaviour (to customize 
material and condition windows) 
GiD_Process command, using a tcl-like parameter list (not space separated list as 
.central.s process), to avoid problem commands as filenames including spaces. 
drawopengl drawentities subcommand (to easily draw internal GiD entities), GiD_Set (to 
set/get GiD variables). 
GiD_Geometry command, to create from tcl new geometric entities. 
Use of PassServer net licences system 
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Use of Dongle licences system, and memory sticks system. 
Bas template: new commands *SetFormatNastran, *ElemsMatProp *LayerNumEntities 
Render saved to disk to avoid to recalculate it. 
New mesh indicator of "shape quality", and "maximum edge" 
New mesh smoothing algorithm for tetrahedras 
ACIS 5.0 Export. New CAD export format 
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Move node utility enhanced, deleting collapsed nodes and elements. 
Mesh from boundary command to generate tetrahedras from a triangle boundary. 
New utilities to mesh edit (smooth a selection and map nodes over geometry). 
Edge collapse enhanced. 
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Fast surface render for some simple cases. 
DXF export: try to export surfaces as 3Dface if possible or else an approximate polyface 
mesh. 
NASTRAN import: new GiD-tcl event procedures to process information in the 
problemtype. 
GiD-tcl info command: new order info parametric line|surface to obtain coordinates, 
derivatives, etc. 
IGES export: if the problemtype has model units, then write these units in the IGES 
output file. 
Import/export materials updated for book and special fields support, and accepted blank 
lines in material or condition file. 
New GiD-tcl command drawopengl to directly draw in GiD from tcl scripts. 
New specialized GiD-tcl commands to manage conditions, materials, local axes, mesh 
edit, etc (GiD_ModifyData, GiD_AssignData, GiD_CreateData, GiD_LocalAxes, 
GiD_IntervalData, GiD_Mesh ). 
Variable 'CalcWithoutMesh' to write the calculation file without mesh entities (for some 
special problemtypes). 
It's possible to set the number of a new volume or planar surface (useful for scripts 
automatization). 
Procserver: get remote calculation server info (available groups,...). 

General preference 'Shrink windows when selection' to resize some windows (layers, 
conditions...) when selecting to facilitate this selection. 
Play sound general preference: to play a sound when some task is finished. 
Tcl: new tcl-GiD event procedures BeforeMeshGeneration and AfterMeshGeneration. 
Tcl: it's possible cancel the calculation from the tcl-GiD event procedures 
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'BeforeWriteCalcFileGIDProject' or 'AfterWriteCalcFileGIDProject' returns '-cancel-' (to 
check data input before calculate). 
Bas template: new commands *ElemsType, *ElemsTypeName, *SetFormatForceWidth, 
*SetFormatStandard, *nelem(OnlyPoints, *set elems(OnlyPoints). 
Backup: each GiD stores their own backup, and asks the user to restore the model if GiD 
crashes. 
Encryption functions. 
Tcl/Tk: internal GiD interpreter updated to Tcl/Tk 8.4.1 version. 
New Shapefile import (useful GIS format). 

Parasolid Import: updated to Parasolid 11 format. 
ACIS Import: updated to ACIS 7 format. 
Custom Render: The user can define new render styles, selecting the layer color to draw 
entities, the visibility, width, etc. (menu View->Render->Customize...) 
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Translation: Added to general preferences a language option. It's possible to add a new 
language copying inside scripts\msgs the appropiated language catalogue message file 
(es.msg, de.msg, etc.) 

Add to dev_kit.tcl some procedures to select GiD coordinates or entities: 
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GidUtils::GetCoordinates, GidUtils::PickEntities (useful for tcl-problemtype developers) 
New mesh renumber option. Setting the variable 'RenumberMethod' to 1, after generate 
a mesh, the nodes are renumbered with a Reverse Cuthill-McKee algorithm. (setting 0 
the old renumber method is applied, and setting -1 the mesh is not renumbered). For 
future versions new algorithms can be included. 

NEW FEATURES - POSTPROCESS

3D Studio .3ds import 
When user set upper or lower result limit, the legend show a box around fixed values 
Show graphs window replacing the old border graph window 



145From v 7 to 8

Multiple mesh and results in a single file 
Can use PNG images for background and textures 
Create graphs between two points in plain surfaces and 3d volumes 
Import NASTRAN mesh associated to FEMAP results 
JPEG Quality variable 
Changed the algorithm of stream lines to a five order Runge-Kutta and for triangles 
Coloured streamlines according to the vector used for the stream line or any other result 
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Multiple mesh support (read, cuts, animations,etc.) 

Enhanced results window (use of a tree widget, etc) 
Show results classified in sublevels: "level_1//level_2" 
New GiD-Tcl commands: GiD_Result create|delete|get (to dynamically create, get or 
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delete results from tcl) 
Femap v1.0 binary results import (.nfo) 
Option 'both sides' when divide mesh and sets 
Background image and texture also in JPEG format 
The lines of the volume meshes are also drawn when the option 'draw interior' is on, and 
not only the internal faces as before 
Cuts can be done giving the coefficients of the cut plane: Ax + By + Cz + D = 0 
Labels, dimensions, comments, legends and axes are scaled with High resolution 
printings ( >200dpi). 
Smooth Contour fill: shows a contour fill with smoothed gauss points results: min, max 
and mean value of the nodal extrapolated results 

Changed the boundaries calculation algorithm, should be faster and uses a little less 
memory than before, also for preprocess- 
New 'Utilities->Report' window for creating reports: images, List Entities info, text, etc. 
can be inserted. 
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New 'Utilities->graphical->animation script' window which allows the user to define a 
sequence of scenes which will be animated 

View can be accessed directly through TclTk with '.central.s info view' and '.central.s 
process view set view ""' 
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New right buttons look 

SOME CORRECTED BUGS - PREPROCESS

DXF import support for encoded 3DSOLID ACIS entities 
Removed several static limits in the bas file 
Some ACIS 7.0 import corrections 
Sweep corrections 
IGES import (surfaces without lines) 
Several semi-structured mesh corrections 
Translation encoding corrections 
Corrected bug when drawing linear and cuadratic prism elements in flat and smooth 
render mode 
When re-meshing, if variable MantainOnldMesh is set to true don't delete elements on 
frozen layers 
DrawMaterials: don't show table of materiales on frozen layers 
Correctes problems when load tbe files 
Some corrections on transform materials 
Avoid to use excessive memory when generating hexahedras with lots of structured 
volumes. 
Corrected bad connectivities when generating structured meshes linked by 
volume-contacts 
Corrected a bug generating tetrahedras with background mesh sizes. 
Avoided geometric entities renumber when generate a mesh. 
Corrected a bug calculating the area of some trimmed surfaces. 
Swapped bad orientation of volume elements created with a copy/move by mirror. 
Corrected slow Reverse Cuthill-McKee renumbering with 1-noded elements. 
Corrected bug of additional random blank spaces in the calculation file. 
A condition over face elems is applied in a interface between materials to two elements 
instead to select only one. 
Corrected crash creating a surfmesh from a quadrilateral mesh. 
Corrected read/write bug of GiD ASCII files with conditions over layer. 
IGES import: more tolerant to files with incoherent data (bad parameter count field 14, 
etc.) 
IGES export: bad output file extension if the user not assigns any extension. 
Bas template: *break can exit a for or a loop 
Corrected Internet retrieve bug with some fast connections. 
Corrected mesh quality graph bugs with small elements. 
The user can cancel the 'quit' function if some process is still running. 
Check of bas numeric format before apply, to avoid crash using some incorrect format. 
Errors with temporary files with not occidental operating systems (Japanese, Korean, 
etc) using filenames with not ASCII characters.

SOME CORRECTED BUGS - POSTPROCESS

Femap import corrections 
Stream lines can also be drawn as points 
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Actualized the results visualized when meshes are switched on and off 
Corrected the problem with cut succesion 
The letters of labels are drawn always, and does not disappear 
Corrected and enchanced the stream-lines algorithm for stream near walls 
Try to read truncated binary result files. 
Corrected bugs when cutting hexahedras by a tangent plane 
Maintain layers colors as set colors 
Several texture corrections 
Correction of the 'Read Batch' windows which swallows the quotes of the batch file 
Independent behaviour for the 'animation controls' and 'animation results' windows 
Corrected the merge (ASCII) option which didn't merge partial values of the same 
result/step/analysis 
Some corrections when selecting results, analysis and steps with the same prefix 
Correction when cutting more than 100 meshes and when cutting volume meshes 
Correction when projecting a texture to the border of the mesh 
When changing the render style for the meshes, it changes the render of the isosurfaces 
too 
Some corrections for the legend and the contour fill ranges for extreme situations: range 
width too small, limits too close, < epsilon 
Correction while reading tecplot files with hexahedras 
Corrected some problems while animating several results at once 
Corrected bug when changing number of colors and contour fill and visualizing several 
results at once 
Corrected the Gauss points extrapolation with given natural coordinates and for 
quadratic elements 
Corrected bad precision calculating eigenvalues and eigenvectors for tensor results.
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What's new from version 6.0.x to 7.0.x 

The meshing parameters used and the GiD version are stored with the model. It is 
possible to list them with the Status command. 
Customization tcl variable GidPriv(TextOfVersion) in the ConfigureProgram.tcl file to 
show in the help (for example, to show the version of a problem type, not the GiD 
version) 
New tcl Order: ".central.s info GiDVersion" (returns the internal GiD version number) 
New tcl Order: info list_entities -more elements "selection" (-more also returns the 
element number, number of nodes and the volume) 
Use of enhanced memory to write the calculation file 
Draw of conditions over layer (the layer entities are drawn) 
New GiD-tcl events send to problemtype.tcl (proc EndGIDPostProcess {} and proc 
LoadResultsGIDPostProcess {file}) 
New *.bas command *LocalAxesDefCenter (returns the center of the user defined local 
axis, similar to LocalAxesDef) 
Inline tutorials (see Help->Tutorials) 
Conditions Window: Entities->AllConditions (lists all conditions of the model) 
New *.bas commands *time and *clock to measure the time used to write the 
calculation file (useful for debug pourposes) 
The right buttons (hidden by default) now open the new conditions, materials, etc 
windows. 
Mesh extrusion enabled in the Copy window 
Split surface (menu Geometry->Edit->Divide->Surfaces->Split): used to divide a 
surface selecting the divide lines (these lines have to intersect the surface contours) 
New *.bas commands related to layers: (*Set Layer LayerName *nodes|elems, *Loop 
nodes|elems *OnlyInLayer, *NodesLayerNum *NodesLayerName *ElemsLayerNum 
*ElemsLayerName) 
Layer window updated 
Mesh only nodes (create elements with one single node) 
New import filter: ACIS V5.0 (files with ".sat" extension) 
Window to edit Nurbs lines and surfaces in "free-form" mode 
Option TangentNurbsL, to force two adjacent Nurbs lines to be tangents 
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Boolean operations (union, intersection, subtraction) in "Solids 2D" (surfaces in same 
plane) 
Variable 'MaintainOldMesh', depending on its value the old mesh is not deleted when 
creating a new mesh (used to mesh separate objects by parts) 
Preference option to force the meshing of entities even if its higher entities are meshed. 
Nastran read enhanced 
Background mesh file, to assign mesh sizes (adaptative remesh) 
Layer commands in the .bas file (commands: *Loop Layer, *LayerName *LayerNum) 
New HTML help 
Utility to draw dimensions (vertex, distance, center, angle, text) 
Selection point: option center (arc or Nurbs with arc shape) 
Draw boundary mesh: interface of material is considered boundary 
Layers: classify in Front or Back (hide) containers 
Multiple surface intersection 
Division of a Nurbs surface selecting the lines to break 
Selecting entities: new options AddToSelection, RemoveFromSel or SwapSelection 
New selection filter window 
New filter selection by element type (e.g. filter:ElementType=TRIANGLE) 
Creation of a Boundary Mesh from a higher mesh (e.g. triangles from a volume mesh) 
RJump mesher: experimental option to create elements jumping between tangent 
contiguous surfaces 
Nurbs surface creation from a cloud of points or level curves (topographic applications) 
Now Conditions can be applied over layers 
HTML support to include help in your problem types 
New TCL functions to customize menus 
New command of the batch file. *****TCL "tcl command", to execute a tcl command in 
a batch file. 
New options available ("Element size" and "Minimum Edge") in the MeshQuality window. 
In the MeshQuality window, if you double click on a value, the elements below/over this 
value are selected. 
Option DrawSizes of the Meshing menu. Different assigned sizes in a mesh are 
represented in different colors. 
Optimization of the Edit Nurbs Line/Surface tool. 
Option SendLayToUse in the contextual menu sends the selection to the Layer in use. 
Option Smoothing in the mesh preferences. 
Option DrawHiger in the Utilities menu, it draws higher entities in different colors. 
New command of the .bas file, *ElemsNnode. This command returns the number of 
nodes of the actual element. (Useful in loops of elements) 
Option Collapse Edges. It has to be applied over a mesh, and it joins nodes that are 
connected by edges shorter than the Import Tolerance value. 
Now it's possible to invoke GiD with option -n2. That option runs the program without 
any window but the Tk library is loaded. 
New Tcl function available, GiDVersionCmp, useful to check the version of the GiD which 
is currently running. 
New command of the .bas file, pow(a,b). 
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'Color Window' in contour options added. 
Legends, comments and axes can be moved around the screen. 
Enhanced Gauss Points support 
JPEG and MJPG support. 
TecPlot ASCII postprocess files supported. 
Femap neutral postprocess files supported. 
New Results file format: more understable. 
New results visualization types: contour ranges with text labels. 
Several improvements: 

More accurate smooth render 
More accurate cut elements generation 
Better management of holes in result values 
High resolution printing 
Better gauss points management: contour values that cannot be extrapolated to the 
nodes, are drawn as coloured balls 

Points support, with variable radius and textures. 
Color improvements for vectors, stream lines, contours, sets, ... 
Separation of sets corresponding to materials or layers in preprocess. 
Names on Volume, Surface and Cut sets. 
Transparent and massive properties independent for each set. 
Added List status of sets, nodes and elements (entities) with results. 
New sets and Results can be merged into the current ones. 
New output possibilities: VRML, animated GIFs, PNG, AVI, pictures of multiple windows. 
Automatic results comments. 
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What's new from version 5.0.x to 6.0.x 

Preprocess

New option 'Arc tangents' let the user create a fillet between two lines that share a 
common end point. 
When creating a NURBS surface, if all lines lie in a plane, it is possible to select the 
boundary lines and the interior lines defining holes at the same time.
It is possible to create a NURBS surface by selecting one line, One surface containing 
this line will be created.
It is possible to create a volume by selecting one surface, One volume containing this 
surface will be created.
When volume cannot be meshed, surfaces with bad quality are exposed tot he user in 
order to help him improve the geometry.
Last meshing size is saved with the GiD model and it appears in the status window and 
also in the ".central.s info project".
Now, one condition over elements can have automatic local axes.
New 'View' menu in the up menus. It contains mostly the same commands than the 
'right button menu' but adding the command 'Multiple windows'. This command permits 
to have several views of the same project.
New option 'Transform problem type' inside menu 'Problem type' in order to adapt data 
from an old problem type to a similar newer one.
New window Assign sizes by cordal error. It allows to select one line to check the 
approximate number of elements that a given cordal error would apply in that line.
New window 'Correct sizes'.
New window 'Macros'. There, several macros can be defined and some keyboard 
shortcuts applied to them.
New non structured quadrilateral mesher.
New mesh quality criteria: Maximum angle.
Added more filters to the selection (when selecting entities write'filter:' in the command 
line) Current filter options are: HigherEntity MinLength MaxLength EntityType 
BadMinAngle BadMaxAngle MinLength and MaxLength can be used also in elements of 
the mesh.
Option Mass in list entities gives information about physical properties: length of lines, 
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center of masses, area of surfaces, and volume of solids. It works either for the 
geometry or for the mesh.
Actualized DXF import filter to version 2000.
New import filter: PARASOLID
New export filters: DXF
Creation of solids: new solids can be created and some of them create the surfaces and 
the interior volume.
Boolean operation with solids (volumes). Union, subtraction, intersection.
Import ASCII and binary STL mesh (also in the surfmesh option).
Condition MESHTYPE can now be: 'over nodes', 'over face elements' or 'over body 
elements'.
There is a new preference to set on or off the 'splash window'.
There is a new option that converts the selected NURBS lines or surfaces to other ones 
very similar to the originals but with and easier definition
The reference manual has a detailed example of problemtype creation.
Preference: 'Surface drawing type' permits to draw the iso-parametric lines in u,v=0.5 
for NURBS surfaces.
A background image can be scaled to the size of the window or can be linked to three 
points of the real model.
Variable 'AllowAutomaticStructured' goes to the preferences window.
It is possible to create volumes when copying surfaces with option 'extrude'.
Smooth elements is now a checkbox in preferences and the angle is given in degrees.
It is possible to obtain interactive help with mouse button 2 or 3 over many windows 
and options.
Conditions window have a new option to differentiate the entities where it has been 
assigned, drawing several colors in the window.
New field #FUNC# can be included in a condition. This is a function that has, as 
variables, the geometry entity num and the position o fthe mesh element or node. It is 
evaluated when meshing is finished or when assigning to mesh.
Now, there can be surfaces in symbols definition (*.geo). Useful for renders.
Added in right button mouse menu the rotation commands: plane XY,XZ,YZ
It is possible to delete one material or take it out from the database. This func is mainly 
for automatization.
Implemented the quadratic 10-noded tetrahedra.
Implemented quadratic surface (2D) contacts.
Implemented a mechanism to detect errors in the execution of external process and 
notify the user.
Just before calculating, GiD changes current directory to the model directory.
When calculating, if there is and error when writing the calculations file, process is 
stopped.
When finished generating mesh, a window with number of generated elements and 
nodes appear.
When writing the calculations file, command *LocalAxesDef(EulerAngles) in the .basfile 
outputs the three Euler angles.
Options 'Calculate' and 'CancelProcess' are included in right menu 'Utilities' and also in 
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the 'Calculate' up menu. This is useful because they enter in a batch file.
A new way of creating local axes: by axe X and angle.
Now, problemtypes can be stored in the subdirectory 'problemtypes' and subdirectories 
inside it forming a tree.
Added a ClearSelection option to all the functions that select entities.
Function Signal entities has a new option : SuperposeLines.
Implemented a new rendering scheme where a hidden mesh is generated. Added new 
preference variable: SurfacePrecision.
Now, when giving a number for a new entity to be created, if there is already one entity 
whith this number, its number is changed.
Option *NodesCoord can be now inside *loop elems. It needs an additional argument 
that gives the local number of the node inside the element.
When layer ToUse is set to off, ToUse is set to NULL. It means that next created entity 
will not be in any layer. Pressing again in ToUse with that layer selected, it will permit to 
use it as active. This process is made to avoid the problem of switching to off the layer 
ToUse and when creating new entities, they disappear from screen. Very annoying!.
Option to avoid meshing entities in frozen layers.
Option Allow automatic structured. If this preference is set, functions like 'Assign sizes 
by Cordal Error' will define some surfaces as structured with highly distorted elements 
over them.
When volume cannot be meshed, surfaces with bad quality are marked.
Last meshing size is saved in the model file and it appears in the status window and also 
in the "info project".
Import/export materials from one exterior database to the current model.
Convert to NURBS surfaces accepts the selection of several surfaces.
It is possible to select the boundary lines and the holes at the same time when creating 
NURBS surfaces (planar) and when trimming one NURBS surface.
Option Search in create NURBS surfaces lets the user select one line and creates one 
surface that contains this line.
Option Search in create volume lets the user select one surface and create all the 
volumes that contain this surface.
Implemented offset for the geometry.
Now, when creating one arc, the second point will always be contained inside it.
It is possible to change the sense of all line types. Also if they have higher entities.
It is possible to change the default color of several entities when displaying in normal 
mode (norender).
New copy and move operation: Offset.
Color of geometrical entities in normal render mode can be selected by the user.
When intersecting surfaces, by default the resulting surfaces are divided. 
New *tcl command in template file (.bas) 

 

Postprocess

Added Standard Bar with common buttons like new, open, print, exit, ...
Added 'Animation controls' window that allows to create movies while rotating, moving, 
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etc. between pre and post automatically or at user request.
Added GIF, BMP and PPM output.
Animations can be saved in AVI True Color, AVI 32768 colors and GIF animated format.
Support for 'high resolution' textures, so images can be of any size.
Added a 'High resolution' option that allows the creation of high detailed pictures.
Added a 'Page Setup' window to facilitate the printing process.
Added command line option to activate 'software rendering' in windows, as workaround 
for problems appeared while using accelerated OpenGL.
Added beam and points elements.
Enhanced the mesh format to allow mixing of elements on the same file.
Added Gauss Points Support for lines/triangles/quadrilaterals/tetrahedras/hexahedras: 
now and old format on manual.
Support for multiple gauss points on several meshes (with the same or different element 
types).
ContourFill/ContorLines and others will do a local interpolation from gauss points with 
internal coordinates to the nodes to draw the results.
Added new result type (main stresses vectors: data_type = 5: vector_1 vector_2 
vector_3 mod_1 mod_2 mod_3
Added new result type (local axes): data_type = 6: angulo_euler_1 angulo_euler_3 
angulo_euler_3local axes are drawn.
On 'Files' menu added several options:· Save 'as ASCII files': saves all the postprocess 
meshes/sets and results on ASCII files.· Save 'as one binary file': saves all the 
postprocess meshes/sets and results on one binary files to speed up further loading 
processes.· Save 'Binary results': saves the results on one binary file to speed up the 
switch between pre and postprocess.
Added join sets to create one set that withholds several ones.
Added collapse nodes option to collapse very near nodes on the viewed sets.
Undesirable meshes/sets/cuts can be deleted.
Added 'Status' window and list>nodes/elements options.
Added divide lines: to extract lines from a set.
Added options 'exact' and 'parallel planes (with distance)' when dividing sets. 
Cuts can be converted to sets, for further cuts, or to save them with theirs results.
By default the last step of the analysis is selected.
Each component of Main stresses can be selected individually when doing "display 
vectors"
One axis of the local axes result type can be selected when doing "display vectors".
Added scalar and vector diagram result visualization, useful for lines when drawing 
beams, with 'show elevations' option.
Added 'Define Contour Limits' window, 'define max/min limit' and 'reset limits' entries on 
the icon bar.
Legends can be displayed outside the graphical windows in a independent window.
Point Options windows added, which allows changing point size and detail ( with 
textures). Also acts on vectors when using the 'point' ending.
Line Options windows added, which allows changing line size and detail. Also acts on 
streamlines.
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Added 'Utilities>Redisplay' option to redo contourfills, contourlines and vectors after 
changing options.This is automatically done when changing some options through the 
'top menu'.
Added option 'VectorDetail' to allow changing between: point/lines/2/4/8 triangles to 
draw the arrows head of vectors.
Added option 'no label' for streamlines.
Added option 'fix absolute limits' to fix limits for all meshes/sets and all steps.
Geometry/Mesh Conditions can be shown when a project is loaded in preprocess.
Added a 'border graph' window that make easier the creation of border graphs.
Added option 'Step delay' and 'add step' to add whole steps to animation file, instead of 
adding several frames to reach the delay.
Changed algorithm to get lines and triangles of volume meshes, 80% faster


